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2.1.3. Teoŕıa de los Funcionales de la Densidad . . . . . . . . . . . . . . . 11
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Resumen

Ante los problemas de abasto energético en el futuro y la contaminación que gene-
ra la quema de combustibles fósiles, es de vital importancia buscar y explotar fuentes
alternativas de enerǵıa renovables y más amigables con el medio ambiente. Una opción
prometedora es el empleo de H2, ya que presenta un alto valor calórico y el producto de
su combustión es agua. Un reto importante para utilizar dicho gas es el almacenamiento
que se pueda hacer de este para su uso. Una manera segura y relativamente eficiente que
se ha explorado es a través de la adsorción en materiales porosos.

Una ruta de estudio para la selección de materiales con caracteŕısticas adecuadas para
los procesos de adsorción es la simulación computacional. Esta permite estudiar rápida-
mente la influencia de las propiedades a nivel molecular para estimar la capacidad de
adsorción de diferentes estructuras y complejos en condiciones dif́ıciles de alcanzar expe-
rimentalmente.

En este trabajo, se realiza un estudio de procesos de adsorción mediante simulaciones
computacionales de una familia de tetracianoniquelatos laminares. Se estudiaron 6 miem-
bros de la familia variando el metal externo (Ni, Co y Fe) y el anillo que funge como
pilar entre las láminas (imidazol y piridina). Mediante cálculos DFT se analizaron las
geometŕıas y los mapas de densidad electrónica de los materiales de partida, aśı como las
interacciones H2-hospedero en los compuestos con imidazol. Las isotermas de adsorción
de H2 en los TCN fueron simuladas con cálculos GCMC para bajas y altas presiones a 77
K.

La optimización de los sistemas dio como resultado dos tipos de estructuras: ondulas
y planas. Las estructuras onduladas tienen como pilar de soporte al imidazol, en cambio
las estructuras planas son con piridina. Los mapas de densidad electrónica demuestran
cómo la geometŕıa influye en la dirección y magnitud de los gradientes eléctricos den-
tro de los canales del material, siendo más fuertes y extendidos en los compuestos con
imidazol. Como resultado, se generan sitios preferenciales para una fuerte interacción gra-
diente eléctrico-momento cuadrupolar, lo cual se corroboró con un cálculo de optimización
TCN-H2 y con los valores de adsorción de H 2 obtenidos mediante la simulación de las
isotermas de adsorción. Las isotermas de los materiales con imidazol sugieren la presencia
de fuertes interacciones huésped-hospedero a 77 K, las cuales son menos importantes para
los materiales con Py.



Abstract

In the face of energy supply problems in the future and the pollution generated by
the burning of fossil fuels, it is important search and exploit alternative sources of energy
and more friendly to the environment. One option is to use H2 it has a high caloric value
and its combustion produces water. An important challenge to use such gas is the storage
that can be made of it for use. A safe and relatively effective way that has been explored
is through adsorption in porous materials.

A study route for the selection of materials with suitable characteristics for the adsor-
ption processes is the computational simulation. This allows to study the influence of the
properties at molecular level to estimate the capacity of adsorption of different structures
and complexes in conditions difficult to reach experimentally.

In this work, a study of adsorption processes is performed by computational simula-
tions of a family of laminar tetracyanonikelates. Six members of the family were studied
by varying the external metal (Ni, Co and Fe) and the ring that acts as a pillar between
the sheets (imidazole and pyridine). DFT calculations analyzed the geometries and elec-
tron density maps of the starting materials, as well as the H 2 - host interactions in the
imidazole compounds. The adsorption isotherms of H 2 in the TCNs were simulated with
GCMC calculations for low and high pressures at 77 K.

The optimization of the systems resulted from the types of structures: corrugated
and flat. The wavy structures have as support pillar to the imidazole, in contrast the flat
structures son with pyridine. The electron density maps show how the geometry influences
the direction and magnitude of the gradient electric within the channels of the material,
being stronger and extended in the compounds with the imidazole. As a result, preferential
sites are generated for a strong gradient electrical-quadrupole moment interaction, which
was corroborated by an optimization calculation TCN-H2 and the obtained H2 adsorption
values by the simulation of adsorption isotherms. The isotherms of imidazole materials
suggest the presence of strong host-host interactions at 77 K, which are less important
for materials with Py.



Caṕıtulo 1

INTRODUCCIÓN

1.1. Generalidades

La dependencia del petróleo y la electricidad han hecho a la generación de enerǵıa un
componente vital de nuestras necesidades diarias. Se estima que en páıses industrializados
una tercera parte de toda la enerǵıa generada anualmente es consumida en transportación,
de la cual, los combustibles fósiles abastecen el 80 %. Los avances tecnológicos basados
en el uso de dichos combustibles provocan su agotamiento y su combustión da lugar a
la emisión de dióxido de carbono (CO2), monóxido de carbono (CO) y otros gases que
intervienen en el efecto invernadero y las lluvias ácidas.

Con el fin de cumplir con el aumento de la demanda de enerǵıa en un futuro próximo y
disminuir los ı́ndices de contaminación, es necesario buscar fuentes alternativas de enerǵıa
que sean ambientalmente limpias. Hay tres opciones principales que están a nuestra dispo-
sición para una generación de menor impacto ambiental en los próximos años: la enerǵıa
carbono neutral (carbono para la captura de combustibles fósiles), la enerǵıa nuclear y
las enerǵıas renovables [4].

Dentro de las enerǵıas renovables que se han desarrollado hasta ahora, una alternativa
es la adopción del hidrógeno como vector energético. Esto se debe a su alto valor calórico
(572 kJ/mol) que es tres veces el de la gasolina, a su alta densidad electrónica de 33.3
kWhkg-1(más grande que el metano de 13.9 kWhkg-1 y la gasolina de 12.4 kWhkg-1), al
hecho de que el producto de su combustión es agua y libera calor, y además, a las faci-
lidades que ofrece su producción. Es un combustible que puede ser producido de forma
ambientalmente limpia, por medio de la electrólisis del agua, empleando enerǵıa solar o
eólica o a través de procesos de catálisis enzimática.

Desafortunadamente, el hidrógeno aún no puede sustituir a los combustibles fósiles, ya
que el hidrógeno molecular (H2) solo existe en cantidades muy pequeñas en la atmósfera
terrestre. La reactividad del hidrógeno con otros elementos reduce aún más la ocurrencia
natural de H2, estando el hidrógeno unido como átomos en agua (H2O), metano (CH4);
aśı como en el carbón, el petróleo, en la qúımica orgánica de los sistemas vivos y en una
multitud de productos. Por lo tanto, aunque H2 es un gas inflamable, no existe dentro
o por encima de la tierra en cantidad suficiente para calificarlo como un combustible
que simplemente puede ser quemado para proporcionar enerǵıa. Más bien, si se desea
hidrógeno molecular para un propósito particular, se tiene que extraer de diversos com-
puestos qúımicos que lo contienen, y esto requiere esfuerzo y enerǵıa. Si se utilizaran
combustibles fósiles para producir hidrógeno, este no seŕıa ya una fuente de enerǵıa lim-
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pia, por lo que la única solución es emplear enerǵıa renovable para producirlo [5].

Este gas a temperatura ambiente y presión atmosférica, ocupa volúmenes muy gran-
des. Por lo que un objetivo deseable es su compactación para su almacenamiento como
paso previo para lograr un uso eficiente y seguro de él.

Hoy en d́ıa existen tanques de alta presión de acero a precios accesibles. En la ma-
yoŕıa de los páıses se usan tanques de hasta 300 bar y regularmente llenos hasta 200 bar.
En el caso del hidrógeno, para almacenar 4 kg se requiere un volumen interno de 225
litros (aproximadamente 60 galones ) o 5 tanques de 45 litros cada uno. Actualmente, se
están desarrollando tanques de alta presión hechos de materiales compuestos de fibra de
carbono reforzado, los cuales se han probado hasta 600 bar; no obstante, se necesita un
recubrimiento interno especial para evitar que la alta presión de hidrógeno reaccione con
el poĺımero. Estos recipientes llenos a alta presión contendŕıan cerca de 4 % de hidrógeno,
pero con ciertas desventajas significativas, principalmente, que la comprensión es peli-
grosa y complicada [6]. Aunado a las cuestiones de seguridad pendientes por resolver, el
almacenamiento en tanques a alta presión aún no cubre las necesidades de las cantidades
energéticas que se requieren por ejemplo, para aplicaciones móviles.

Otra propuesta para almacenar gases que cumplan criterios de seguridad y tengan
una mayor densidad a temperaturas cercanas a la ambiente, es la utilización de materia-
les nanoporosos. Uno de los materiales más estudiados para la adsorción de gases son los
enrejados metal-orgánicos (MOF’s). Los MOF’s tienen una gran área superficial, que los
hace atractivos para la adsorción de gases. Adicionalmente, se sintetizan de forma modu-
lar y debido a que son estructuras compuestas por “nodos”formados de iones metálicos
enlazados a ox́ıgeno o ligandos orgánicos constituyen arquitecturas ajustables: es posible
ensamblar diferentes combinaciones de nodos de metal y enlaces orgánicos para obtener
una gran variedad de materiales únicos con diferentes afinidades para los diferentes gases.

Otros materiales nanoporosos para el almacenamientos de diferentes gases son los
llamados ZIF’s (Zeolitic imidazolate framework), que son una subfamilia de MOF’s, los
cuales muestran excepcional estabilidad térmica. Debido a su alta estabilidad, amplia
variedad topológica, e intŕınsecas propiedades hidrofóbicas, los ZIF’s son muy atractivos
para muchas aplicaciones de separación. Otra caracteŕıstica estructural interesante de los
ZIF’s es que tienen grandes poros (11.6 Å en el ZIF-8 y 14.6 Å en el ZIF-11) y aberturas
pequeñas (3.4 Å para el ZIF-8 y 3.0 Å para el ZIF-11). Los tamaños de las pequeñas
aberturas son similares al diámetro cinético del H2 (2.9 Å), permitiendo que el H2 pue-
da entrar en el poro grande del ZIF y a la vez excluir otras moléculas más grandes. La
máxima afinidad de una molécula de H2 por un ZIF se produce cuando las aberturas (o
poros) son del mismo tamaño que el diámetro cinético de H2 [7].

Por otra parte, se tienen los materiales laminares tetracianoniquelatos (TCN), los cua-
les se estructuran por planos que se forman en la estructura a través de un metal externo
unido a 4 grupos cianos en una coordinación cuadrada plana en los ejes XY, mientras que
en el eje vertical el metal está conectado a anillos aromáticos (tipo piridina o imidazol)
que sirven como pilares de soporte entre las láminas. Estos pilares solo están unidos por el
nitrógeno de los anillos a los metales y es mediante la interacción de dos anillos, uno unido
en el plano inferior y el otro en el plano superior, que se genera el esfuerzo de soporte. Los
TCN son sólidos h́ıbridos de fórmula qúımica T(Im)2[Ni(CN)4], donde el metal T 2+ se
encuentra en coordinación octahédrica a seis átomos de nitrógeno. Gracias a la ausencia
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(a) (b)

(c)

Figura 1.1: Ejemplos de materiales nanoporosos. (a) ZIF [1]; (b) MOF [2]; (c)TCN [3].

de impedimentos estéricos en las moléculas que actúan como pilares, los mismos pueden
rotar en la región de las capas intermedias; y este efecto modifica la geometŕıa del sistema,
el volumen de la cavidad y la funcionalidad de la superficie interior. Además, esta fami-
lia cuenta con un amplio volumen interno, lo que los hace candidatos para la retención
de moléculas [3]. Algunos ejemplos de este tipo de materiales se puede ver en la Figura 1.1.

Un detalle geométrico interesante a investigar es que las láminas que forman estas
estructuras, en algunos casos son muy rectas y en otros presentan forma ondulada. Gon-
zales et. al [8] mostraron que la ondulación que muestran los planos de la estructura de
los compuestos con los que trabajaron está relacionado con efectos estéricos de los grupos
sustituyentes del anillo imidazol. Por lo tanto, las distancias tanto entre metales como
entre los planos tiene una dependencia con el metal externo y la forma de los pilares
de las láminas o planos. Sin embargo, cuando los anillos imidazol no tienen un grupo
sustituyente, no hay efecto estérico. Entonces, ¿qué influye para que las láminas de los
materiales sean onduladas o planas?, y principalmente, ¿influye la configuración para de-
terminar cuál de estos materiales tendrá mejor adsorción?

Una ruta de estudio para la selección de materiales con caracteŕısticas adecuadas para
los procesos de adsorción es la simulación computacional. Los experimentos realizados por
computadora son útiles para estimar la capacidad de adsorción de diferentes estructuras y
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para profundizar en los fenómenos de interacción a nivel molecular. También proporciona
una imagen detallada en la escala molecular que no es fácilmente accesible empleando
los métodos experimentales. Además, la simulación permite estudiar a nivel molecular
la influencia de varias propiedades (superficie, tamaño y forma de poro) en el compor-
tamiento de adsorción, ayudando aśı en el diseño y desarrollo de los nuevos materiales [9].

El presente trabajo presenta un estudio teórico de la adsorción de H2 en los materiales
laminares TCN utilizando cálculos cuánticos (ab initio y la Teoŕıa de los Funcionales de
la Densidad) y simulaciones Monte Carlo Gran Canónico (GCMC). Hasta el momento,
los TCN se han empleado en aplicaciones magnéticas. Sin embargo, en este trabajo, se
lleva a cabo un estudio teórico-computacional previo a su empleo como potenciales mate-
riales para la adsorción de H2. Los materiales seleccionados tienen la variante en el metal
de ensamble a los anillos y en los anillos en śı que interactúan para dar rigidez al pilar
de sostén entre planos, esto fue aśı para la facilidad de tener variables controladas que
pudieran ser analizadas de una manera común.

1.2. Hipótesis y objetivos

Hipótesis:

Con ayuda de cálculos teóricos basados en DFT y GCMC, es posible evaluar el
rendimiento de materiales laminares tetracianoniquelatos como candidatos para el
almacenamiento de H2.

Es posible explicar a nivel teórico las diferencias entre los tipos de materiales aten-
diendo a su estructura (laminar ondulado y laminar plano). Los ondulados pueden
presentar interacciones más fuertes y espećıficas con la molécula de H2 que los de
estructura laminar plana.

Objetivo general: Determinar qué tipo de materiales laminares tetracianoniquelatos
presentan una mejor capacidad de adsorción de H2 mediante simulación computacional
de las isotermas de adsorción, y establecer los sitios más probables para la interacción
huésped-hospedero.

Objetivos particulares:

Optimizar mediante cálculos DFT las estructuras de los TCN.

Obtener los mapas de distribución de densidad electrónica correspondientes a las
estructuras optimizadas para determinar posibles sitios de adsorción de H2 en los
materiales.

Realizar una optimización TCN-H2 y analizar el tipo de interacciones huésped-
hospedero.
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Calcular las isotermas de adsorción de H2 con métodos de Dinámica Molecular en
el rango de bajas (hasta 1 atm) y altas presiones (hasta 120 atm) a 77 K.

Correlacionar los sitios de ocupación a muy bajas presiones de las moléculas de H2

con los mapas de distribución de densidad electrónica de los adsorbentes.

1.3. Estado del arte

Los recientes estudios computacionales en el análisis de estructuras cristalinas de mate-
riales con capacidad de adsorción de gases se dividen en gran medida en tres metodoloǵıas:
1) Cálculos ab initio o Teoŕıa de los Funcionales de la Densidad (DFT) para estudiar las
interacciones de la molécula huésped y el material, 2) simulaciones GCMC para predecir
cantidades de adsorción de los gases en el adsorbente, 3) simulaciones de dinámica mole-
cular (MD) para analizar la difusión de gases en ellos.

En lo que respecta a las simulaciones GCMC y MD, para lograr una predicción del
número de moléculas de H2 en los poros cercana a los datos experimentales reportados,
se requiere de campos de fuerza más precisos que puedan modelar mejor la interacción
de la molécula huésped y la estructura hospedera; actualmente los campos de fuerza más
utilizados son UFF y DREINING.

Debido a las caracteŕısticas de las simulaciones computacionales, muchos investigado-
res han estado utilizando estos experimentos virtuales para investigar el almacenamiento
de gases en MOF’s, COF’s, ZIF’s, etc [10].

1.3.1. Adsorción de H2 en diversos materiales

Yang y Zhong [11] (2006) simularon las isotermas de H2 a 298 K y por encima de 70
bar para IRMOF- 1 y Cu-BTC (también conocido como HKUST-1) utilizando el campo
de fuerza FF63 OPLS-AA. Mostraron que su simulación se parećıa a los datos experimen-
tales. También realizaron su técnica de simulación en el MOF-505, en este caso el metal
contiene sitios abiertos. Encontraron que los sitios de metal abiertos tienen una influencia
favorable en la adsorción de H2 en los MOF; sin embargo, este último material mostraba
una baja adsorción de H2 a temperatura ambiente.

Por otra parte, Jung et al. [12] (2006) estudiaron el efecto de catenación en la ad-
sorción de hidrógeno sobre 3 MOF’s (IRMOF-9, IRMOF-11 y IRMOF-13). Utilizaron
el método GCMC y el campo de fuerza universal (UFF), y demostraron que los poros
pequeños generados por el encadenamiento puede desempeñar un papel importante para
confinar las moléculas de hidrógeno más densamente. Todos los estudios de GCMC fueron
desarrollados por el programa Sorption en el paquete MS 4.0.

G. Garberoglio [13] (2007) realizó por primera vez la simulación de adsorción de H2

en los sistemas de COF. En este reporte, se utilizaron 4 materiales (COF-102, COF-103,
COF-105 y el COF-108) a 77 y 298 K usando UFF y DREIDING, mostrando que el
COF-105 arrojaba mejores resultados a 77 K y el COF-108 a 298 K. La adsorción fue
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simulada con la técnica GCMC.

Han et al. [14] (2007) realizaron cálculos MP2 (second-order Moller-Plesset) para
desarrollar campos de fuerzas para la adsorción de H2 en un conjunto de MOF’s, y calcu-
laron isotermas a 77 K y presiones de hasta 1 bar. La isoterma simulada especialmente en
el IRMOF-1 presenta un comportamiento similar con los datos experimentales de Row-
sell [15]. También Han et al [16] (2006) desarrollaron campos de fuerza para una serie de
COF’s, y el resultado más favorable se dio en el COF-5, ya que la isoterma de adsorción
de H2 se asemeja con los datos experimentales; aqúı se usaron condiciones de 77 K y
presiones de hasta 90 bar.

Jung et al. [17] (2007) realizaron un cálculo con un potencial ajustado a los datos
experimentales. Primero, utilizaron los parámetros UFF para que coincidiera con las iso-
termas de H2 experimentales en IRMOF-1 e IRMOF-18 para presiones de hasta 1 bar
a una temperatura de 77 K. Luego, aplicaron estos parámetros UFF modificados para
simular la adsorción de H2 en IRMOF-3, IRMOF-9 , IRMOF-11 e IRMOF-13 a 77 K. Sus
simulaciones concordaban razonablemente con los datos experimentales para IRMOF-3,
IRMOF-11 e IRMOF-13. Sin embargo, para el IRMOF-9, los puntos calculados sobres-
timaron en gran medida a la isoterma experimental; dicha inconcordancia fue atribuida
por los autores a la pérdida de cristalinidad de la muestra experimental.

Ryan et al. [18] (2008) calcularon isotermas de H2 en IRMOF-1 (también conocido
como MOF-5). Éste es un MOF formado a partir de nodos Zn4O conectados entre śı con
moléculas de ácido 1,4-bencenodicarbox́ılico. Se realizaron los cálculos para presiones de
hasta 120 bar a 77 y 298 K, con el modelo de Lennard-Jones y campos de fuerza UFF.
De esta forma, obtuvieron resultados comparables con los datos experimentales de Kaye
et al. [19] a través de todo el rango de presión (0 hasta 120 bar).

Liu et al. [20] (2008) sintetizaron un nuevo MOF, [Zn(BDC)(Ted)0,5](BDC= ben-
cenodicarbox́ılico, ted= trietilendiamina), y mostraron que los datos experimentales se
asemejan con la simulación de isotermas a 77 y 298 K en el que utilizaron campos de
fuerza UFF y DREIDING. La simulación se realizó con el método GCMC. Nuevamente,
Liu et al. [21] (2008) realizaron el cálculo de isotermas con la misma metodoloǵıa pero
con el material Cu3(BTC)2. Sin embargo, a 77 K, los datos experimentales no concuerdan
con el resultado de la simulación.

Han et al. [7] (2010) simularon isotermas de 10 diferentes MOF’s con nodos de Zn(II)
o Co(II) con enlaces de tipo imidazolato, en un rango de presiones arriba de 100 bar, y
a 77 y 300 K, con el fin de ver la influencia de varios grupos sustituyentes en el anillo
imidazol en el almacenamiento de H2. Descubrieron que cuando se agrega un grupo sus-
tituyente al enlace imidazolato mejoraba la adsorción de H2 a 77 K y bajas presiones, ya
que la enerǵıa de enlace del H2 aumentaba. Sin embargo, a altas presiones la captura de
H2 disminuyó, lo cual se atribuyó debido a la disminución en el área superficial. Lo que
concluyeron fue que para estos materiales y a presiones tanto bajas como altas, deben
considerar MOF’s con una gran área superficial y con poros pequeños de igual magnitud
que el diámetro cinético de H2. En este trabajo los cálculos de GCMC fueron realizados
en el software Cerius2. Usaron campos de fuerzas interatómicos basados en cálculos MP2.

Bae y Snurr et al. [22] (2010) investigaron el almacenamiento de H2 en ocho MOF’s
(UMCM-1, MOF-177, Cu-BTC, IRMOFs-1, IRMOFs-9, IRMOFs-10, IRMOFs-15, IRMOFs-
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16) para presiones de 120 y 1.5 bar con temperaturas de 77 y 298 K usando simulación
GCMC. Se incrementaron sistemáticamente los parámetros de Lennard-Jones para inter-
acciones H2-MOF y aśı modelar el comportamiento de los QST (calores de adsorción).
Sus resultados sugirieron que una gran superficie es más importante que un gran volumen
libre para lograr una capacidad máxima de almacenamiento de H2 bajo estas condiciones.

Han et al. [7] (2010) presenta el comportamiento de la adsorción de H2 de 10 ZIF’s de
diferentes topoloǵıas (ZIF-2, ZIF-3, ZIF-8, ZIF-10, ZIF-11, ZIF-68, ZIF-69, ZIF-70, ZIF-
78, y ZIF-79). En algunas de ellas se le agregó un grupo funcional al anillo imidazol para
observar si exist́ıa una influencia de ellos sobre la adsorción de H2. Los autores utilizaron
campos de fuerza que describen las atracciones de Van der Waals para las interacciones de
H2 y los ZIF’s. Por lo tanto, estas predicciones de la adsorción de H2 se basan en cálculos
ab initio y por consiguiente pueden ser aplicables a nuevos materiales para los que no hay
datos emṕıricos. Las condiciones fueron hasta 100 bar a 77 y 300 K. A 77 K, la inclusión de
un grupo funcional es útil para mejorar la adsorción de H2 a baja presión (1 bar) debido a
que la enerǵıa de interacción de H2 aumenta la presión por un efecto del grupo funcional.
Sin embargo, a presiones altas (100 bar) este no mejora la captación máxima de H2, ya
que disminuye el área superficial (o volumen de poros) de ZIF’s debido a su efecto estérico.

Garberoglio et al. [23] (2005) investigaron la influencia de los efectos de difracción
cuánticos en la adsorción de H2 por IRMOF-1 e IRMOF-8 a 77 K. Se utilizaron poten-
ciales de Lennard-Jones e isotermas con y sin considerar los efectos de difracción cuánti-
ca para la adsorción de H2. Para las simulaciones que utilizan los efectos de difracción
cuántico se tomó el método de las integrales de camino (path integral) de Monte Carlo
(PIMC). Las simulaciones fueron razonablemente parecidas con los datos experimentales,
incluso cuando los efectos de difracción cuántica no fueron tomadas en cuenta. Además,
observaron resultados más favorables a cargas altas cuando se consideraron los efectos de
difracción cuántica.

En este mismo trabajo, los autores investigaron el efecto de incluir carga, ya sea en
las interacciones cuadrupolares entre el enrejado y las móleculas de H2, como entre las
interacciones cuadrupolo-cuadrupolo entre las moléculas de H2 mediante el modelo Dar-
krim Levesque (DL) [24]. Además, los resultados utilizando el potencial de Buch en el
IRMOF-1 a 77 y 298 K. Las simulaciones a 77 K y con el potencial Buch estaban en
razonable concordancia con los datos experimentales para presiones de hasta 1 bar, pero
las simulaciones del potencial DL sobrestimaron en gran medida los experimentos. Dicha
sobreestimación fue atribuida a las fuertes interacciones cuadrupolo-cuadrupolo entre las
moléculas de H2. Sin embargo, a 298 K, las simulaciones con ambos potenciales presen-
taron comportamientos similares a los resultados experimentales para presiones de hasta
70 bar. Observaron que las simulaciones a temperatura ambiente de ambos potencia-
les Buch y DL eran casi idénticas una de la otra, y concluyeron que las interacciones
carga-cuadrupolo y cuadrupolo-cuadrupolo son esencialmente insignificantes a tempera-
tura ambiente y a presiones de hasta 50 bar para la adsorción de H2 en el IRMOF-1.

En resumen, lo que se puede observar en las investigaciones reportadas trata sobre
la adsorción de H2 en una amplia variedad de materiales. De igual forma, dan una idea
concreta sobre los parámetros importantes para la simulación, como son los campos de
fuerza que en su mayoŕıa son UFF, DREINING y en otros casos, campos de fuerzas que
los autores desarrollaron de acuerdo a los materiales que estudian. Un campo de fuerza
se refiere al conjunto de parámetros que se utilizan para calcular la enerǵıa potencial de
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un sistema de átomos o part́ıculas en la mecánica molecular y simulaciones de dinámica
molecular. Los parámetros de las funciones de la enerǵıa se pueden derivar de trabajo
experimental y cálculos de mecánica cuántica. Para determinar la capacidad de almace-
namiento de los gases en materiales nanoporosos, se utiliza en mayor medida el método
GCMC, empleando diferentes campos de fuerzas.

Por otra parte la dinámica molecular ha permitido que se estudien varios parámetros
de la adsorción. Además del trazo de las isotermas, se estudian calores de adsorción (QST),
difusión y los sitios más factibles para la interacción de adsorbato-adsorbente. Debido a
la facilidad para implementar los cálculos, una gran parte de los programas de qúımica
computacional utilizan funciones base, que éstas representan los orbitales que se desean
modelar. Para los materiales nanoporosos se utilizan bases grandes, ya que son sistemas
con varios electrones en la capa de valencia, debido en la mayoŕıa de los casos a los metales
de transición. El empleo de bases grandes mejora la flexibilidad de las funciones de onda,
pero aumenta el costo computacional.

Como ya se mencionó, los MOF’s y los ZIF’s cuentan con poros casi esféricos en los que
existen gradientes de campo eléctrico que permiten una mayor interacción con moléculas
que tengan momento cuadrupolar. Los materiales laminares tetracianoniquelatos no tie-
nen la geometŕıa de MOF’s o ZIF’s pero presentan algunas caracteŕısticas que pudieran
servir para aplicaciones de adsorción como lo son el espacio disponible entre planos y la
disponibilidad de metales semidesnudos; y en el caso de los laminares ondulados la posi-
bilidad de un gradiente mediante la curvatura de las láminas. Estos sistemas se eligieron
con el fin de entender los fenómenos relevantes en la interacción adsorbato-adsorbente
para diseñar materiales con mayor capacidad de adsorción.
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Caṕıtulo 2

MARCO TEÓRICO

2.1. Modelos para la solución a la Ecuación de Schröndin-

ger

2.1.1. Ecuación de Schröndinger

Erwin Scröndinger postuló un modelo para la descripción de la interacción de un
electrón en un átomo con varios protones basándose en la hipótesis de De Broglie que
consideraba que el electrón pod́ıa comportarse como una part́ıcula u onda. El modelo de
Schrödinger se basa en describir el comportamiento del electrón o de un sistema dinámico
usando ecuaciones matemáticas. Esta ecuación está en términos de la función de onda Ψ,
que a su vez predice anaĺıticamente la probabilidad de eventos en el sistema descrito. Para
problemas de estructura electrónica se utiliza la ecuación de Schröndinger independiente
del tiempo, no relativista, que tiene la forma siguiente:

HΨ(r) = EΨ(r) (2.1)

donde H es el operador Hamiltoniano y Ψ es un conjunto de soluciones o eigenvectores
del Hamiltoniano. Cada solución Ψn tiene asociado un eigenvalor, En, un número real que
satisface la ecuación de eigenvalores. Los valores espećıficos del Hamiltoniano dependen
del sistema f́ısico que será descrito por la ecuación de Schröndinger. Para una descripción
completa donde múltiples electrones están interactuando con el núcleo, la ecuación de
Schröndinger completa se representa como:[

h2

2m

N∑
i=1

∇2
i +

N∑
i=1

V (ri) +
N∑
i=1

∑
j<i

U(ri, rj)

]
Ψ = EΨ (2.2)

donde m es la masa del electrón. Los tres términos en los corchetes representan, en
orden, la enerǵıa cinética de cada electrón, la enerǵıa de interacción entre cada electrón
con el núcleo y la enerǵıa de interacción entre los diferentes electrones. Ψ es la función de
onda electrónica, que es una función de cada una de las coordenadas espaciales de los N
electrones, por lo cual Ψ = Ψ(r1, ..., rN), y E es el estado de enerǵıa base de los electrones.

El problema con el Hamiltoniano es que el término que define las interacciones electrón-
electrón es dif́ıcil de resolver, ya que la función de onda electrónica individual Ψi(r), con-
sidera las funciones de onda electrónicas individuales de los otros electrones.

Como no es posible obtener una solución exacta para sistemas complejos como molécu-
las, se han desarrollado varios métodos aproximados. Existen métodos basados en fun-
ciones de onda de pocas part́ıculas como átomos y moléculas pequeñas, pero cuando es
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necesario encontrar la función de onda de sistemas de 3N coordenadas, se va a requerir
mucho tiempo de cálculo y memoria de almacenamiento, por lo cual, se opta por alter-
nativas que disminuyan estos factores. Existen aproximaciones que son alternativas para
la resolución de sistemas complejos, como lo son el método de Hartree Fock, Métodos
PosHartree-Fock y la Teoŕıa de los Funcionales de la Densidad.

2.1.2. Hartree-Fock

Existen técnicas PosHartree-Fock que se obtienen al sustituir un determinante de Sla-
ter en la ecuación de Schröndinger, siendo éstas, funciones de onda de un solo electrón. En
estas ecuaciones el hamiltoniano exacto es sustituido por el operador de Fock: FΨ = EΨ.
El operador de Fock, en lugar de considerar que los electrones interactúan uno a uno me-
diante un potencial coulómbico como lo hace el hamiltoniano exacto, éstos mantienen una
interacción promedio con todos los electrones del sistema. En este método, las ecuaciones
HF son independientes para cada electrón.

La función de onda de HF está escrita como un producto antisimétrico, llamado de-
terminante de Slater de orbitales φi, y el método HF consiste en buscar los orbitales φi
que minimizan la enerǵıa del sistema, basándose en la ecuación:

F (1)φi(1) = εiφi(1) (2.3)

donde εi es la enerǵıa del orbital y F es el operador Fock, definido como:

F (1) = h(1) +

N/2∑
j=1

[2Jj(1)−Kj(1)] (2.4)

donde h(1) es el denominado operador monoelectrónico h = −1
2
∇2

1 −
∑

α
Zα
r1α

, el cual re-
presenta la enerǵıa cinética del electrón más la enerǵıa potencial de la atracción entre el
electrón y el núcleo; Jj son el operador coulómbico, que representa la repulsión electrón-

electrón: Jj(1)f(1) = f(1)
∫ |φj(2)|

r12
dv2, siendo f una función arbitraria; y Kj el operador

de intercambio, definido como KJ(1)f(1) = φj(1)
∫ φ∗j f(2)

r12
.

El problema con el método de HF, se encuentra en la suposición de que la función
de onda de muchos electrones toma la forma de un determinante de Slater. Pero una
función de onda de muchos electrones no puede expresarse como un determinante único,
esto quiere decir, que los movimientos electrónicos están correlacionados unos con otros.
Como resultado, los métodos de Hartree-Fock no incorporan completamente la correlación
electrónica y las enerǵıas resultantes tienden a ser demasiado altas. Si se encuentra una
base completa de funciones de onda de un solo electrón, entonces se puede expresar la
función de onda de muchos electrones como una combinación lineal de todos los determi-
nantes posibles de éstas. Esto se conoce como interacción de configuración.

Desafortunadamente, el método HF tiene un número de dificultades en su aplicación.
Existen técnicas PosHartree-Fock que se expanden sobre esto, como son: interacción de
configuraciones, métodos perturbativos y cúmulos acoplados.

La Teoŕıa de los Funcionales de la Densidad (DFT), que fue desarrollada a principios
de los años 60, supera estas dificultades. Esta teoŕıa lleva tal nombre, debido a que siendo
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la densidad electrónica una función de la posición, ésta es referida como un funcional.

El único observable que puede medirse es la probabilidad de que los N electrones
estén en un conjunto de coordenadas. En otras palabras, la cantidad de interés f́ısico es la
probabilidad de encontrar un conjunto de N electrones en cualquier coordenadas r1, ..., rN .
Está probabilidad se puede representar estrechamente con la densidad electrónica en una
posición particular en el espacio, n(r), que puede escribirse en término de las funciones
de ondas electrónicas individuales

n(r) = 2
∑
i

Ψ̄i(r)Ψi(r) (2.5)

El término dentro de la sumatoria es la probabilidad de que un electrón en la función
de onda individual Ψ(r) está situado en la posición r. El término 2 aparece por el princi-
pio de exclusión de Pauli, que establece que cada función de onda electrónica puede ser
ocupada por dos electrones con diferente spin cada uno [25].

2.1.3. Teoŕıa de los Funcionales de la Densidad

Aproximación de Born-Oppenheimer

La clave para facilitar el cálculo del hamiltoniano está en las simplificaciones que se
pueden realizar. La primera simplificación es la aproximación de Born-Oppenheimer y se
basa en el hecho de que los núcleos son más pesados que los electrones mn >> me (Good-
siman, 1973). Esto lleva como consecuencia que los electrones se muevan más rápido que
los núcleos. Entonces, se considera que los núcleos se encuentran fijos mientras que los
electrones se mueven alrededor de ellos. De esta manera se elimina el término de enerǵıa
cinética de los núcleos y el hamiltoniano se simplifica con los términos del Hamiltoniano
electrónico y la repulsión entre los núcleos (He + VNN)Ψe = UΨe.

Como las variables en la ecuación de Schröndinger son las coordenadas electrónicas,
VNN es independiente; aśı se considera una constante y se omite, dejando la ecuación en
término de electrones.

En la aproximación de Born-Oppenheimer, el estado base de electrones se obtiene con-
siderando el campo de los núcleos. En el Hamiltoniano la enerǵıa cinética de los electrones
y la interacción electrón-electrón se ajustan al potencial externo, el cual es debido a los
núcleos. Por lo tanto el potencial externo es la única variable requerida [25].

Teoremas de Hohenberg y Kohn

El término V (ri) de la ecuación 2.2 como bien se mencionó es la enerǵıa potencial
entre el electrón i y los núcleos que depende de las coordenadas (−→r ) del electrón i y de
las coordenadas nucleares. Pero al utilizar un sistema con núcleos fijos, las coordenadas
de los núcleos dejan de ser variables y la enerǵıa potencial v(ri) sólo depende de las coor-
denadas electrónicas; esto se conoce como el potencial externo que actúa sobre el electrón
i. Con el potencial externo v(ri) establecido y el número de electrones n en el sistema, se
puede determinar la función de onda y la enerǵıa de la molécula al solucionar la ecuación
de Schröndinger.
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Con esta criterio, Hohenberg y Kohn demostraron “ el primer teorema de Hohen-
berg y Kohn” que dice: La enerǵıa del estado base de la ecuación de Schröndiger es un
funcional único de la densidad electrónica.

“El segundo teorema de Hohenberg-Kohn” define una propiedad importante del
funcional: La densidad electrónica que minimiza la enerǵıa de todo el funcional es la ver-
dadera densidad electrónica correspondiente a la solución de la ecuación de Schröndinger.
Si se conociera el funcional ”verdadero”se podŕıa variar la densidad electrónica hasta que
la enerǵıa del sistema fuera mı́nima, dándonos pistas para encontrar la densidad electróni-
ca. Sin embargo, éstos problemas que residen en la naturaleza del funcional se corrigieron
cuando Kohn y Sham propusieron un método de aproximaciones, para obtener el valor de
la densidad electrónica de manera más práctica y sencilla.

Método de Kohn-Sham

Las ecuaciones de Kohn-Sham tiene la forma[
h2

2m
∇2
i + V (r) + VH(r) + VXC(r))

]
Ψ(r) = εiΨi(r) (2.6)

En orden, los términos son, el potencial que define las interacciones entre el electrón
y las coordenadas nucleares. El segundo es el potencial de Hartree definido como

VH(r) = e2
∫
n(r′)

|rr′
d3r′. (2.7)

Este potencial describe la repulsión coulombica entre el electrón y la densidad electróni-
ca total. VXC define las aportaciones de intercambio y correlación a las ecuaciones de un
electrón, es decir, explica la atracción y repulsión entre los espines. Éste término formal-
mente, está dado por:

VXC(r) =
δEXC(r)

δn(r)
(2.8)

Para resolver las ecuaciones de Kohn-Sham, se necesita el potencial Hartree, y des-
pués de definir el potencial de Hartree se necesita conocer la densidad electrónica. Pero,
al conocer a la densidad electrónica, se necesita conocer las funciones de onda de un solo
electrón, y conociendo éstas funciones se deben resolver las ecuaciones de Kohn-Sham.
Las ecuaciones de Kohn-Sham son procesos iterativos, que se resuelven de forma auto-
consistente.

Campo autoconsistente

Campo autoconsiste, mejor conocido como “el método SCF” que deriva de sus siglas
en inglés “Self-Consistent Field”, es un método de cálculo que resuelve incógnitas de
manera iterativa. Se anexa un ejemplo del algoritmo que sigue este método al optimizar
la geometŕıa, en la Figura 2.1

Funcional de intercambio-correlación

Kohn, Hohenberg y Sham nos mostraron que el estado fundamental que buscamos
puede encontrarse minimizando la enerǵıa del funcional, y que esto se puede lograr encon-
trando una solución autoconsistente a un conjunto de ecuaciones de una sola part́ıcula.
Sin embargo, no existe un funcional de intercambio-correlación general, solo está resuelto
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Figura 2.1: Diagrama de flujo para el cálculo autoconsistente de Kohn-Sham, para un sistema
molecular con geometŕıa fija y para la optimización de la geometŕıa.
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para un gas de electrones uniformes.

La enerǵıa de intercambio es la reducción energética del sistema electrónico debido a
la antisimetŕıa de la función de onda. Y la enerǵıa de correlación es la diferencia entre
la enerǵıa de un sistema multielectrónico y la enerǵıa calculada con la aproximación de
Hartree-Fock.

En la actualidad, se han desarrollado varios métodos para encontrar aproximaciones a
este funcional, y aśı, aproximarse a la ecuación 2.8; algunas de estas aproximaciones son:
aproximación local de la densidad (LDA) y Aproximaciones de Gradiente Generalizado
(GGA) [25].

2.2. Estado sólido

2.2.1. Ley de Bragg

La estructura de los cristales se estudia mediante la difracción de fotones, neutrones
y electrones. Aśı, en una estructura cristalina tridimensional, debido a su periodicidad,
es posible construir conjuntos de planos que son paralelos entre śı, igualmente espaciados
y conteniendo idénticas disposiciones atómicas. El proceso consiste en la dispersión de
los rayos X por las nubes electrónicas que rodean a los átomos del cristal originando un
patrón de difracción regular, resultado de la interferencia constructiva y destructiva de la
radiación dispersada por todos los átomos.

Para que se difracten los rayos-X, es decir, para que el resultado de la interferencia
sea constructiva, se debe cumplir la Ley de Bragg:

2dsinθ = nλ (2.9)

Esta expresion se puede escribir también como:

2k ·G+G2 = 0 (2.10)

Los términos de la ecuación anterior se explicarán con detenimiento posteriormente.

La hipótesis de Bragg establece que el ángulo de incidencia es igual al ángulo de
difracción. Debido a la naturaleza repetitiva del cristal, estos planos estaŕıan separados
entre śı por distancias constantes d. Aparecen haces difractados cuando las reflexiones
procedentes de planos de átomos paralelos interfieren constructivamente, como se indica
en la Figura 2.2.
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Figura 2.2: Descripción de la ecuación de Bragg

La reflexión de Bragg puede producirse únicamente para longitudes de onda que cum-
plan λ ≤ 2d.

La deducción de Bragg da una indicación clara de la condición necesaria para que se
obtenga la interferencia constructiva de las ondas dispersas en los puntos de la red [26].

Análisis de Fourier

Un cristal es invariante bajo cualquier traslación de la forma T = u1a1 + u2a2 + u3a3,
donde u1, u2, u3 son enteros y a1, a2, a3 son los ejes del cristal. De las propiedades f́ısicas
invariantes bajo T son la concentración de carga, la densidad numérica de los electrones
o la densidad del momento magnético.

Las propiedades más interesantes de los cristales están directamente relacionadas con
los componentes de Fourier de la densidad electrónica. La densidad numérica electrónica
n(r) puede aplicarse a un análisis de Fourier, debido a que es una función periódica de r,
con peŕıodos a1, a2, a3 en las direcciones de los tres ejes del sólido. Por lo cual, la densidad
puede expresarse como

n(r + T ) = n(r) (2.11)

En análisis de Fourier de funciones periódicas n(r) de tres dimensiones, la densidad
puede escribirse de la siguiente manera:

n(r) =
∑
G

nGexp(iG · r) (2.12)

Se debe encontrar el conjunto de vectores G tal que las traslaciones T dejen invariante
al cristal. Los coeficientes de Fourier, representados como nG, determinan la amplitud de
la dispersión de los rayos X [26]. Dichos coeficientes se representan como:

nG = V −1c

∫
celda

dV n(r)exp(−iG · r) (2.13)

Red rećıproca

Toda estructura cristalina tiene dos redes asociadas: la red cristalina y la red rećıproca.
La red rećıproca es una red en el espacio de Fourier asociado con el cristal.

Para encontrar los vectores G de la sumatoria de Fourier n(r) =
∑

G nGexp(iG · r),
primero se construyen los vectores axiales b1, b2, b3 de la red rećıproca:
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b1 = 2π
a2 × a3

a1 · a2 × a3
; b2 = 2π

a3 × a1
a1 · a2 × a3

; b3 = 2π
a1 × a2

a1 · a2 × a3
(2.14)

siendo b1, b2, b3 los vectores primitivos de la red rećıproca. Cada vector de 2.6 es orto-
gonal a dos vectores axiales de la red cristalina. Estos vectores cumplen con la propiedad

bi · aj = 2πδij (2.15)

Los puntos de la red rećıproca vienen dados por el conjunto de vectores

G = v1b1 + v2b2 + v3b3 (2.16)

De acuerdo a que el vector de la red rećıproca G tiene la invariancia deseada bajo
cualquier traslación T = u1a1 +u2a2 +u3a3, podemos escribir la representación de Fourier
de la densidad electrónica de la siguiente manera:

n(r + T ) =
∑
G

nGexp(iG · r)exp(iG · T ) (2.17)

Teorema. El conjunto de vectores G de la red rećıproca determina las posibles refle-
xiones de los rayos X.

Figura 2.3: Condiciones de difracción

En la Figura 2.3 la diferencia de factores de fase es exp[i(k − k′) · r] entre los haces
dispersados a partir de elementos de volumen que están separados entre śı la distancia
r. Los vectores de onda de los haces incidentes y dispersados son k y k′. La amplitud de
los vectores de campo eléctrico o magnético en la onda electromagnética dispersada es
proporcional a la integral

F =

∫
dV n(r)exp[i(k − k′) · r] =

∫
dV n(r)exp(−i∆k · r) (2.18)

llamada amplitud de dispersión. En donde

k + ∆k = k′ (2.19)

mide la variación del vector de onda y se denomina vector de dispersión. Sustituyendo
la ecuación 2.12 en 2.18 se obtiene la ecuación de amplitud de dispersión en términos de
la densidad electrónica

F =
∑
G

∫
dV nGexp[i(G−∆k) · r] (2.20)
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Zona de Brillouin

El valor de la zona de Brillouin consiste en la interpretación geométrica singular de la
condición de difracción 2k ·G = G2. Dividiendo entre 4 obtenemos

k ·
(

1

2
G

)
=

(
1

2
G

)2

(2.21)

Un haz de rayos X dentro del cristal se verá difractado si su vector de onda k tiene
el módulo y dirección requeridos por la ecuación 2.21 [26]. La construcción de Brillouin
presenta todos los vectores de onda k que pueden sufrir una reflexión tipo Bragg en el
cristal. Para construir lo que seŕıa celda unidad en el espacio rećıproco, es lo que se
denomina zona de brillouin.

Método de la supercelda

Aunque existen ciertos observables del problema de muchas part́ıculas que se pueden
mapear en observables equivalentes de un problema de una sola part́ıcula efectiva, aun aśı,
continúa la formidable tarea de tratar con un número grande de electrones moviéndose en
un potencial estático debido a un número grande de núcleos o iones. Por lo cual, además
de calcular una función de onda para cada electrón que estén en el sistema, también es
necesario un conjunto base grande para expandir cada función de onda, esto debido a que
cada función de onda se extiende en todo el sólido. Estos problemas se pueden resolver
realizando el cálculo en un sistema periódico y aplicando el teorema de Bloch a las fun-
ciones de onda [27].

Los cristales, sistemas con periodicidad se pueden considerar infinitos, pero en siste-
mas como nanoestructuras, la periodicidad se rompe. En estos casos se construye una
supercelda, donde hay suficiente distancia de separación entre el sistema de estudio y sus
réplicas para que la interacción entre ellas sea despreciable. Con supercelda nos referimos
a los vectores que definen la celda volumen y las posiciones atómicas dentro de la celda.
Esta definición de supercelda es el más básico archivo de entrada para un cálculo DFT.

2.2.2. Teorema de Bloch

Resulta que muchas partes de los problemas matemáticos planteados por DFT son más
convenientes resolver en términos de k que en términos de r, cuando se trata de sistemas
periódicos. El teorema de Bloch establece que en un sistema periódico cada función de
onda electrónica, puede ser escrita como el producto de una función periódica y de una
onda plana

Ψi(−→r ) = expi
−→
k ·−→r fi(−→r ) (2.22)

A su vez, la función periódica de la función de onda puede expandirse con un conjunto
de bases de ondas planas, en los que los vectores de onda son vectores de la red reciproca
del sólido

fi(−→r ) =
∑
−→
G

C
i,
−→
G

expi
−→
G ·−→r (2.23)

Donde G está definido como: −→
G · −→l = 2πm (2.24)
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∀−→l , donde
−→
l es un vector de red del cristal y m es un número entero. Por lo cual, las

funciones de onda electrónica pueden escribirse como una suma de ondas planas

Ψi(−→r ) =
∑
−→
G

C
i,
−→
k +
−→
G

expi(
−→
k +
−→
G )·−→r (2.25)

Puntos k

Para un sistema periódico, las integrales en el espacio real sobre el sistema (infini-
tamente extendido) son reemplazadas por integrales sobre la primera zona de Brillouin
(finita) en el espacio rećıproco, en virtud del teorema de Bloch. Dichas integrales se reali-
zan sumando los valores de la función del integrando (por ejemplo: la densidad de carga)
en un número finito de puntos en la zona de Brillouin, llamada malla de k puntos. La
elección de una malla suficientemente densa de puntos de integración es crucial para la
convergencia de los resultados y, por tanto, es uno de los principales objetivos cuando se
realizan pruebas de convergencia.

Con el fin de facilitar la elección de k-puntos, muchos software ofrecen paquetes con
la posibilidad de elegir k puntos de acuerdo con el esquema propuesto por Monkhorst
y Pack [28]. Esto esencialmente significa que los k-puntos de muestreo se distribuyen de
forma homogénea en la zona de Brillouin, con filas o columnas de puntos k paralelas a los
vectores rećıprocos de reticulación que abarcan la zona de Brillouin.

Los cálculos pseudopotenciales de enerǵıa total se pueden utilizar para determinar
una amplia variedad de propiedades f́ısicas de los materiales. Los cálculos se realizan en
superceldas periódicas permitiendo aśı que las funciones de onda electrónicas se expandan
en términos funciones de ondas planas en cada uno, de un conjunto infinito de k puntos
en la zona de Brillouin. Esto a su vez, permite la aplicación de las dos aproximaciones:
En primer lugar, un pequeño número de k-puntos se eligen cuidadosamente para represen-
tar con precisión la función de onda en todos los kpoints (Chadi y Cohen 1973, Monkhorst
y Pack 1976).

En segundo lugar, truncando la base establecida, las funciones de onda en cada punto
k se puede ampliar en términos de un conjunto de base finita. En principio, aumentando
el número de k puntos y el tamaño del conjunto de bases es la convergencia absoluta de
enerǵıa [29].

Enerǵıas cutoff

De acuerdo al teorema de Bloch, decimos que la solución a la ecuación de Schröndinger
para sistemas periódicos es la ecuación 2.22, y las funciones periódicas se expresan en la
ecuación 2.23, donde la sumatoria son todos los vectores definidos por G = v1b1 + v2b2 +
v3b3. El problema con lo anterior, es que evaluando la solución en cada punto en el espacio
rećıproco, la sumatoria contiene un número infinito de posibles valores de G. Esto seŕıa
dif́ıcil para la realización de cálculos. Pero las funciones de la ecuación 2.22 son soluciones
de la ecuación de Schröndiger donde son soluciones con enerǵıa cinética [30]. Aśı,

E =
h2

2m
|k +G|2 (2.26)
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Figura 2.4: Esquema de los potenciales para todos los electrones (ĺınea continua) y para los
pseudoelectrones (ĺınea punteada) y sus correspondientes funciones de onda. El radio a partir del
cual los valores del potencial y la función de onda para todos los electrones y los pseudoselectrones
coinciden, se conoce como radio de corte rc.

Para que el resultado sea razonable, es necesario truncar la suma infinita e incluir solo
soluciones con enerǵıa cinética a ciertos valores:

Ecut =
h2

2m
G2
cut (2.27)

Lo cual, obtendŕıa la siguiente solución

Ψk(r) =
∑

|G+k|<Gcut

Ck+G exp[i(k +Gr)] (2.28)

Pseudopotenciales

Cuando se resuelve la ecuación de Schrödinger para un sólido de átomos se consideran
tres tipos de componentes con propiedades bastante diferentes: los núcleos iónicos, los
electrones internos y los electrones de valencia. Los electrones de valencia están locali-
zados en las capas más externas del átomo. Por el contrario, los electrones internos se
quedan fijos, es decir, el estado de estos electrones prácticamente no se ve alterado cuan-
do el átomo aislado es introducido en un sólido. Estos están localizados en las capas más
profundas del átomo. La aproximación del pseudopotencial hace uso de estas ideas [31,32].

La aproximación del pseudopotencial también elimina los electrones internos repre-
sentándolos por un pseudopotencial más suave que el potencial iónico original actuando
sobre unas pseudofunciones de onda suaves (Figura 2.4). Estas pseudofunciones se pue-
den expandir con un número mucho más pequeño de ondas planas, lo que hace menor el
tiempo de cómputo y el espacio de almacenamiento.

Un pseudopotencial se desarrolla considerando un átomo aislado de un elemento, pe-
ro el pseudopotencial resultante puede entonces ser utilizados confiablemente para los
cálculos que ponen este átomo en cualquier ambiente qúımico (transferibilidad del pseu-
dopotencial). Los códigos actuales de DFT proporcionan una biblioteca de pseudopoten-
tiaciales que incluyen por lo menos un archivo para la mayoŕıa de los elementos de la

19



tabla periódica.

Una propiedad importante de los pseudopotenciales, es el valor de la enerǵıa de corte
requerida para el conjunto base de ondas planas. Pseudopotenciales que requieren altas
enerǵıas de corte se dice que son pseudopotenciales duros, mientras que más pseudo-
potenciales computacionalmente eficientes con bajo corte de enerǵıas se denominan como
pseupotenciales suaves [30].

2.3. Mecánica Estad́ıstica

2.3.1. Entroṕıa y temperatura

Por la mecánica cuántica, sabemos que un sistema tiene diferentes estados que son ei-
genvectores del Hamiltoniano del sistema. Para sistemas de muchas part́ıculas, es muy pro-
bable que exista la degeneración en niveles de enerǵıa. Vamos a designar como Ω(E, V,N)
al número de eigenvectores con enerǵıa E de un sistema de N part́ıculas en un volumen
V . Un sistema con N , V y E fijos es igualmente probable que se encuentre en cualquiera
de sus eigenvectores Ω(E).

Si tenemos dos sistemas (los denominaremos como E1 y E2), se dice que están en
equilibrio si cumplen lo siguiente:(

∂ ln Ω1(E1)

∂E1

)
N1,V1

=

(
∂ ln Ω2(E2)

∂E2

)
N2,V2

(2.29)

Introduciendo la siguiente notación

β(E, V,N) ≡
(
∂ ln Ω(E, V,N)

∂E

)
N,V

(2.30)

Podemos representar la ecuación 2.29 como

β(E1, V1, N1) = β(E2, V2, N2) (2.31)

Claramente, en la ecuación 2.31 la enerǵıa de los sistemas está en equilibrio, y cuando
este es alcanzado, ln Ω del sistema total es un máximo. Por lo tanto, ln Ω es relacionado
a la entroṕıa termodinámica S del sistema.

S(N, V,E) ≡ kB ln Ω(N, V,E) (2.32)

donde kB es la constante de Boltzman. Por lo tanto, decimos que todos los estados
cuánticos degenerados de un sistema cuántico son igualmente probables, esto implica, en
equilibrio térmico, que la entroṕıa de un sistema es en un máximo. La entroṕıa está re-
lacionada con la densidad de estados de un sistema con enerǵıa E, volumen V y número
de part́ıculas N .

Por otro lado, decimos que dos sistemas que están en contacto térmico están en equi-
librio si su temperatura es la misma. La definición termodinámica de temperatura es

1/T =

(
∂S

∂E

)
V,N

(2.33)
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entonces
β = 1/(kBT ) (2.34)

Ahora, si tenemos un sistema, denominado A, que está en equilibrio térmico con
un baño térmico, denominado B, supondremos que el sistema A es preparado en un
estado cuántico espećıfico i con enerǵıa Ei. La degeneración del baño térmico determina
la probabilidad Pi de encontrar el sistema A en el estado i:

Pi =
ΩB(E − Ei)∑
j ΩB(E − Ej)

(2.35)

donde E −Ei = EB, representa la enerǵıa del baño térmico. Esta ecuación de proba-
bilidad puede escribirse también como la distribución de Boltzmann para un sistema
con temperatura T.

Pi =
exp(−Ei/kBT )∑
j exp(−Ej/kBT )

(2.36)

La distribución de enerǵıa nos permite calcular la enerǵıa promedio 〈E〉 del sistema
en una temperatura dada T :

〈E〉 =
∑
i

EiPi =

∑
iEi exp(−Ei/kBT )∑
iEj exp(−Ej/kBT )

= −∂ ln
∑

iEi exp(−Ei/kBT )

∂1/kBT
(2.37)

= − ∂ lnQ

∂1/kBT
(2.38)

donde, en la última ĺınea, se define la función de partición. Las funciones de partición
se relacionan con los potenciales termodinámicos.

Consideremos el valor promedio de algunos observables A como 〈A〉. Sabemos la pro-
babilidad de que un sistema a temperatura T se encuentre en un eigenvector energético
con enerǵıa Ei ,y por lo tanto, podemos calcular el promedio térmico del observable A
como la siguiente ecuación:

〈A〉 =

∫
dpNdrN exp−β[

∑
i p

2
i /(2mi) + U(rN)]A(pN , qN)∫

dpNdrN exp−β[
∑

i p
2
i /(2mi) + U(rN)]

(2.39)

Condición ergódica

Una propiedad importante en la mecánica estad́ıstica, es la ergocidad. La teoŕıa ergódi-
ca establece que: “promedios temporales y promedios de ensamble coinciden en el ĺımite
de tiempos muy largos”. Es decir,

ρi(r) = 〈{ρi(r)}〉NV E (2.40)

donde ρi(r) es una función temporal

ρi(r) = ĺım
t→∞

1

t

∫
dt′〈ρi(r; rN(0), pN(0), t′)〉NV E (2.41)

donde rN representa las coordenadas de los átomos y pN es el momento de todos los
átomos.
Y la función de ensamble

〈ρi(r; rN(0), pN(0), t′)〉NV E (2.42)
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El término ensamble establece el promedio sobre todos los estados cuánticos posibles de
un sistema. Es decir, la egorcidad consiste en que promediando todas las coordenadas ini-
ciales de espacio es equivalente a promediar todas las coordenadas espaciales del tiempo
evolucionado. Si queremos calcular el promedio de una función de las coordenadas y mo-
mentos de un sistema de muchas part́ıculas, podemos calcular esa cantidad por promedio
de tiempo o por promedio de ensamble.

2.3.2. Monte Carlo

La expresión clásica de una partición Q, es la siguiente:

Q = c

∫
dpNdrN exp[−H(rNpN)/kBT ] (2.43)

donde rN representa las coordenadas de las N part́ıculas y pN para los correspondien-
tes momentos. La función H(rN , pN) es el Hamiltoniano del sistema que representa el
total de enerǵıa de un sistema aislado como una función de coordenadas y momentos de
las part́ıculas constituyentes: H = K + U , donde K es la enerǵıa cinética del sistema, U
es la enerǵıa potencial y c es una constante de proporcionalidad elegida tal que la suma
de todos los estados cuánticos sea enfocada a la función clásica de partición.

La ecuación clásica para un sistema A expresada en función de coordenadas y momen-
tos, se representa como:

〈A〉 =

∫
dpNrNA(pN , rN) exp[βH(pN , rN)]∫

dpNrN exp[βH(pN , rN)
(2.44)

donde β = 1/kBT . La técnica para resolver la ecuación de A, es el método Monte Carlo
con el algoritmo Metrópolis.

El método de Metrópolis

Usando simplemente el método Monte Carlo es dif́ıcil calcular la función de parti-
ción, por lo que el algoritmo de Metrópolis resuelve la ecuación 2.44. Lo que el método
Metrópolis demuestra es que es posible diseñar un esquema eficiente de Monte Carlo para
muestrear un sistema.

Primero se genera un sistema en un configuración rN , nombrado como o, que tiene un
factor de Boltzman exp [−βU(o)]. Luego, se genera una nueva configuración r′N , que nom-
bramos como n, mediante un desplazamiento aleatorio 4 a o. Aqúı, el factor de Boltzman
será exp [−βU(n)]. Ahora se debe decidir si se acepta o rechaza la configuración prueba.
Muchas reglas para tomar esta decisión satisfacen la restricción de que en promedio la
probabilidad de encontrar el sistema en una configuración n es proporcional a la densidad
de probabilidad denotada como N(n).

Sea la función N(rN) la densidad de probabilidad de encontrar el sistema en una
configuración alrededor de rN se representa como

N
[
rN
]
≡

exp
[
−βu(rN)

]
Z

(2.45)

Ahora vamos a deducir el algoritmo de Metrópolis para determinar la probabilidad de
transición π(o → n) para ir de la configuración o a n. Se denotará el número de puntos
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en cualquier configuración por m(o). Se quiere que en promedio, m(o) sea proporcional a
N(o). La matriz π(o→ n) debe satisfacer una condición: no se destruye tal distribución de
equilibrio una vez que se alcanza. Esto quiere decir que, en equilibrio, el número promedio
de movimientos de prueba aceptados que resultan en el estado de salida del sistema debe
ser exactamente igual al número de movimientos de prueba aceptados en todos los demás
estados n al estado o.

Existen muchas formas posibles para la matriz de transición π(o → n). Recordamos
que un movimiento de Monte Carlo consta de dos etapas: primero, realizamos el movi-
miento de prueba del estado o a n. Escribimos la matriz de transición que determina la
probabilidad de realizar un movimiento de prueba desde o a n como α(o → n), donde
α es la matriz de la cadena de Markov. El siguiente paso es la decisión de aceptar o
rechazar el movimiento prueba. Se va denotar la probabilidad de aceptar o rechazar el
movimiento prueba como acc(o→ n).

π(o→ n) = N(o→ n)× acc(o→ n) (2.46)

Para la probabilidad de aceptar o rechazar el movimiento prueba, la elección de
Metrópolis es la siguiente:

acc(o→ n) =


N(n)/N(o) si N(n) < N(o)

1 si N(n) > N(o)
(2.47)

En el algoritmo de Metrópolis, la probabilidad de transición de ir del estado o al estado
n, está dada por:

π(o→ n) =


α(o→ n) si N(n) ≥ N(o)

α(o→ n)[N(n)/N(o)] si N(n) < N(o)

α(o→ o)[N(n)/N(o)] = 1−
∑

n6≡o π(o→ n)

(2.48)

Ahora, para decidir si un movimiento prueba es aceptado o rechazado, el procedimiento
es el siguiente. Si generamos un movimiento prueba del estado o al estado n, con U(n) >
U(o), esta movimiento prueba deberá ser aceptada con una probabilidad

acc(o→ n) = exp−β[U(n)− U(o)] < 1 (2.49)

Para decidir si se acepta o rechaza el movimiento, se genera un número aleatorio,
nombrado como Ranf. Entonces, la probabilidad que Ranf se menor que acc(o → n) es
igual a acc(o → n). Aceptamos el movimiento de prueba si Ranf < acc(o → n) y de lo
contrario se rechaza.

Algoritmo

El método Metrópolis se introdujo como un proceso de Markov en el que un camino
aleatorio se construye de tal manera que la probabilidad de visitar un punto particular
rN es proporcional al factor de Boltzmann exp[−βU(rN)]. En el enfoque introducido por
metrópolis, se propone el siguiente esquema:

1. Seleciona una part́ıcula al azar, y calcula su enerǵıa U(rN).
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2. Dar a la part́ıcula un desplazamiento aleatoriamente, r′ = r+4, y calcula su enerǵıa
U(rN).

3. Acepta el movimiento desde rN a r′N con la probabilidad de

acc(o→ n) = min(1, exp[−β[U(r′N)− U(rN)]. (2.50)

2.3.3. Ensamble Gran Canónico

Como un sistema se define por la colección de un gran número de part́ıculas, “en-
samble”se puede definir como la recopilación de un número macroscópicamente idénticos,
pero sistemas esencialmente independientes. Con el término de medios macroscópicamente
independientes, significa, que cada uno del sistema que constituye un ensamble satisface
las mismas condiciones macroscópicas, como el volumen, la enerǵıa, la presión, la tempe-
ratura y el número total de part́ıculas, etc.

Para estudios de adsorción, lo natural es el uso del ensamble gran canónico (o
ensamble[µ, V , T ]). Como experimentalmente las condiciones de equilibrio son que la
temperatura y el potencial qúımico del gas dentro y fuera del adsorbente deben ser igua-
les, tenemos que conocer solamente la temperatura y el potencial qúımico depósito para
determinar la concentración de equilibrio dentro del adsorbente. Esto es exactamente lo
que se imita en el conjunto gran canónico: la temperatura y el potencial qúımico son fijos
y el número de part́ıculas fluctúa durante la simulación.

El método Metrópolis calcula promedios térmicos de funciones A(rN) que depende las
coordenadas de una molécula en un sistema de N part́ıculas, como por ejemplo la enerǵıa
potencial o la contribución de la presión. Pero este método no determina el valor de la
integral

∫
drN exp[...βU(rN)]. Por lo que el método Metrópolis no es usado para determi-

nar propiedades termodinámicas de un sistema que depende de esta integral. A pesar de
que el método Metrópolis no puede ser utilizado para medir, en principio, enerǵıas libres
directamente, este puede ser utilizado para mejorar la diferencia de enerǵıas libres entre
dos posibles estados de un sistema de N-part́ıculas. Este hecho es explotado en el método
gran canónico de Monte Carlo.

Las ecuaciones correspondientes para la simulación de Monte Carlo en el ensamble
gran canónico son las siguientes [33]:

Q(µ, V, T ) ≡
∑ exp(βµN)V N

Λ3NN !

∫
dsN exp[−βU(sN)] (2.51)

donde µ = kBT lnΛ3ρ, que representa el potencial qúımico que está relacionado con
la densidad de la part́ıcula ρ, V es el volumen, T es la temperatura, N es el número de
part́ıculas, Λ =

√
h2/(2πmkBT ), y sN representa las coordenadas escaladas.

y la densidad de probabilidad correspondiente es:

Nµ,V,T (sN ;N) ∝ exp(βµN)V N

Λ3NN !
exp[−βU(sN)]. (2.52)

2.4. Adsorción

La adsorción es un fenómeno que sucede en la superficie, en el cual, las part́ıculas (gas
o ĺıquido) forman enlaces débiles o fuertes con los átomos de la superficie del material,
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debido a interacciones electrónicas.

De acuerdo a lo establecido por la IUPAC (Sing et al. 1985; Haber, 1991; Rouquerol
et al., 1994), el término adsorción se entiende universalmente como significando el enri-
quecimiento de uno o más de los componentes en la región entre dos fluidos (es decir, la
capa interfacial).

La adsorción tiene gran importancia tecnológica. Algunos adsorbentes se utilizan co-
mo catalizadores, otros para la separación de gases, purificación de ĺıquidos, control de la
contaminación o protección. En particular, la adsorción de gases determina la superficie
de área y el tamaño de poro de diversos materiales porosos. El volumen de poro es definido
como el bien dice su nombre, el volumen de poros abiertos, pero puede incluir el volumen
de poros cerrados. Aunque no siempre es fácil distinguir entre rugosidad y porosidad o
entre Poros y vaćıos. Para referirse a un sólido poroso es sólo si las irregularidades super-
ficiales son más profundas que anchas.

Existen dos tipos de fuerzas para las interacciones que existen en la adsorción: fisisor-
ción y quimisorción.

Fisisorción: La fisisorción es un proceso en el cual la estructura electrónica del átomo
o molécula es dif́ıcilmente alterado al ser adsorbido. Las moléculas mantienen su identi-
dad y en la desorción regresan a su forma original. En f́ısica molecular, el mecanismo
correspondiente es un enlace de van der Waals, en el que la fuerza de atracción entre
las dos especies se debe a la inducción de momentos dipolares entre ellas. Las part́ıculas
fisisorbidas se caracterizan por tener una enerǵıa de enlace baja (aproximadamente 100
meV), distancias relativamente grandes entre ellas y la superficie (de 3 a 10°A) y relativa
facilidad para moverse en el plano paralelo a la superficie. El estudio de especies fisisor-
bidas requiere bajas temperaturas. El tiempo de residencia de las part́ıculas fisisorbidas
se puede calcular usando con la siguiente ecuación:

τ = τ0 exp
Ea
kbT (2.53)

Aqúı, τ es el tiempo de residencia de la part́ıcula fisisorbida, τ0 = 10−12, Ea es la
enerǵıa de enlace o de adsorción, Kb = 1,38062x10−23JK conocida como la constante de
Boltzman, y T es la temperatura del sustrato.

Ahora, en la quimisorción las moléculas sufren una reacción o una disociación, y pier-
den su identidad. En el proceso de quimisorción se forma un enlace qúımico, equivalente
a los enlaces covalentes o iónicos, entre el adsorbato y el sustrato, lo cual significa que
la estructura electrónica de ambos es fuertemente perturbada debido a la interacción,
formando orbitales h́ıbridos.

2.4.1. Tipos de isotermas de adsorción

La relación, con temperatura constante, entre la cantidad adsorbida y presión cons-
tante, o concentración, es conocida como isoterma de adsorción.

La cantidad de gas adsorbido na, por masa ma, de un sólido es dependiente de la
presión de equilibrio p, la temperatura T , y la naturaleza del sistema (gas-sólido). Podemos
representarla como:

na/ma = f(p, T, sistema) (2.54)
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Figura 2.5: Esquema de las 6 formas de isotermas, según la clasificación de la IUPAC

Para un gas adsorbido sobre un sólido a temperatura constante, tenemos

na/ma = f(p)T (2.55)

y si el gas está por debajo de su temperatura cŕıtica, tenemos

na/ma = f(p/po)T (2.56)

donde, po es igual a la presión de saturación de la adsorción en T.
Las ecuaciones anteriores representan las isotermas de adsorción.

Fisisorción de gases

La mayoŕıa de las isortermas por adsorción f́ısica, están agrupadas por una clasificación
de 6 clases, según la IUPAC, como se ve en la Figura 2.5.

La isoterma tipo I se caracteriza porque la adsorción se produce a presiones relativas
baja. Caracteŕıstica de los sólidos microporosos.

La isoterma tipo II es caracteŕıstica de sólidos macroporosos o no porosos, tales
como negros de carbón.

La isoterma tipo III ocurre cuando la interacción adsorbato-adsorbente es baja.
Ejemplo: adsorción de agua en negros de carbón grafitizados.

La isoterma tipo IV es caracteŕıstica de sólidos mesoporosos. Presenta un incremento
de la cantidad adsorbida importante a presiones relativas intermedias, y ocurre
mediante un mecanismo de llenado en multicapas.

La isoterma tipo V, al igual que la isoterma tipo III, es caracteŕıstica de interacciones
adsorbato adsorbente débiles, pero se diferencia de la anterior en que el tramo final
no es asintótico.

La isoterma tipo VI es poco frecuente. Este tipo de adsorción en escalones ocurre
sólo para sólidos con una superficie no porosa muy uniforme. Ejemplo: adsorción de
gases nobles en carbón grafitizado.
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Caṕıtulo 3

METODOLOGÍA

Existe software que son herramientas útiles para la simulación de procesos de adsor-
ción. Dentro de los software, existen algunos con el desarrollo computacional enfocado a
cálculos mecanocuánticos (ab initio, DFT-periódico). Dentro de este grupo de software
se encuentran VASP, Gaussian, SIESTA y Quantum ESPRESSO. Una de las diferencias
entre estos software radica en que algunos son software de código abierto, y por lo tanto,
es más sencillo adquirirlos.

Quantum ESPRESSO (QE), es un software integrado de códigos computacionales,
además de ser de código abierto, para cálculos de estructura electrónica y modelado de
materiales a escala nanométrica. Se basa en la Teoŕıa de los Funcionales de la Densidad,
ondas planas y pseudopotenciales.

Por otro lado, existen software desarrollados para cálculos de dinámica molecular. En
esta rama de simulación computacional, se encuentran software como: GROMACS, DL-
POLY, LAMMPS, entre otros.

LAMMPS es un código de dinámica molecular clásica. Sus iniciales vienen de Large-
scale Atomic/Molecular Massively Parallel Simulator. LAMMPS tiene potenciales para
materiales de estado sólido (metales, semiconductores) y materia blanda (biomoléculas,
poĺımeros) y sistemas de grano grueso o mesoscópico. Puede usarse para modelar átomos
o, más genéricamente, como un simulador de part́ıculas paralelas a escala atómica, meso
o periódica.

Para la simulación de procesos de adsorción de los TCN, se realizaron estudios con dos
softwares de código abierto: QE para cálculos basados en la Teoŕıa de los Funcionales de
la Densidad (DFT) que predicen sitios de adsorción en base a la densidad electrónica [34].
LAMMPS, para cálculos basados en el método Gran Canónico Monte Carlo, para fines
de simulación de isotermas de adsorción en sistemas sólidos [35].

3.1. Quantum ESPRESSO

QE, realiza cálculos de densidad electrónica que conlleva mapas de distribución de
densidad electrónica. Estos mapas muestran regiones tanto de acumulamiento como de
escasez de electrones, dando un panorama cualitativo de los sitios con mayor probabilidad
de retener moléculas huésped.
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Figura 3.1: Página oficial de Quantum espresso

Figura 3.2: Página oficial de LAMMPS
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DFT es una herramienta útil para cálculos en sistemas de muchas moléculas como
son los sistemas cristalinos. Se aproxima a una geometŕıa que represente una superficie
ideal, es decir, aquella superficie que se encuentre en la enerǵıa más baja posible. Para
sistemas cristalinos las ecuaciones matemáticas implicadas en DFT resultan complicadas,
por lo que es necesario resolverlo con transformadas de Fourier. Para resolverlo, es nece-
sario llevar los cálculos al espacio rećıproco. En el espacio rećıproco, la red cristalina se
denominada red rećıproca. Como sabemos, la celda unidad de un cristal se refiere a un
conjunto de átomos a partir del cual se puede generar el cristal entero por traslación en
las tres dimensiones del espacio; en el espacio rećıproco esta celda unidad se denomina
zona de Brillouin.

Para cálculos de sistemas periódicos, es necesario cumplir con el teorema de Bloch
y tener bases grandes que simulen los sistemas, estas bases son las funciones de ondas
planas. Para cumplir con el teorema, es necesario especificar cuantos puntos k deben ser
usados en cada dirección del espacio rećıproco que integren todo la zona de Brillouin.
Cabe mencionar, que dichos puntos k son las diferentes ondas que cumplen con la Ley de
Bragg que intentan modelar como están los electrones en la red.

Eligiendo estos puntos se podrá simular el volumen en el que el sistema empieza a
ser convergente. Aunque en una aproximación entre más elementos se tenga, más preciso
será, en estos cálculos, debido al tiempo computacional se necesita encontrar un balance
entre eficiencia y tiempo de cómputo. Por lo que es necesario encontrar enerǵıas de corte
de los puntos k que modelan los electrones que se encuentran en la red.

Por otra parte, los electrones internos se encuentran cerca del núcleo y repelen los
electrones de afuera, por lo que es posible hacer una aproximación en la que se reemplaza
el potencial coulombico por otro de menor costo computacional, en el que los electrones
internos se modelen como un potencial fijo y solo calcular las propiedades de los electrones
más externos, llamado pseudopotencial.

3.1.1. Uso de la interfaz de Materials studio y Gulp para la
creación de un input de QE

QE es un motor de cálculo en el cual, es necesario crear un archivo de entrada para los
cálculos requeridos. El input de QE (versión espresso-4.3.2) consiste en una serie de ĺıneas
de un archivo de texto ASCII. La estructura básica de un archivo input de QE incluye di-
ferentes secciones, los cuales se especifican con más claridad en la página del software [34].
Para fines de este trabajo, primero se realizaron cálculos de enerǵıa, preprocesamiento,
para encontrar los parámetros óptimos que darán una mayor eficiencia computacional en
los cálculos posteriores.

Para la preparación del input del cálculo de enerǵıa en QE (dentro del input, dicho
cálculo está representado en la ĺınea de comando como SCF [self-consistent field]), se ne-
cesitan varios software: Materials studio (MS) [36] y Gulp [37].

El archivo de entrada para el primer software a utilizar, MS, es un archivo .cif. En
estos archivos se encuentra la información cristalográfica de los materiales, excepto de los
hidrógenos que contenga la estructura. Por lo cual, se requiere MS, ya que cuenta con la
herramienta para agregar los hidrógenos faltantes en los sistemas, además que cuenta con
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la opción de exportar el archivo generado como .cif.

Materials studio 5.0

Figura 3.3: Materials Studio

A continuación, se presentan los pasos a seguir para la preparación en el software MS.

1. Abrir el programa “Material studio” y crear un proyecto.

2. Ir a File ⇒ Import, y abrir el archivo .cif a trabajar.

3. Para un uso más didáctico se puede visualizar con más claridad la molécula, cambiar
el modo de visualización dirigiéndose a View ⇒ Display Style. Por ejemplo, a Ball
and Stick.

4. Ir a Build ⇒ Bond, dejar las opciones por default y pulsar “Calculate”, esto para
calcular automáticamente el tipo de enlace (si se desea modificar el tipo de enlace,
seleccionar el enlace, ir a Modify ⇒ Modify Bond type).

5. Para agregar hidrógenos (H) al material, seleccionar la molécula a la cual se le desea
agregar H, ir a Modify ⇒ Modify hibridization, y elegir el tipo de hibridización
correspondiente. Después ir nuevamente a Modify ⇒ Adjust Hydrogen.

6. Seleccionar Build ⇒ Crystal ⇒ Rebuild crystal. Si los datos que se presentan son
iguales a los datos cristalográficos del .cif de entrada, seleccionar Apply.

7. Para guardar el nuevo archivo .cif, ir a File ⇒ Export, y guardarlo con extensión
.cif.
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Figura 3.4: Ejemplo de archivo cif

El archivo de salida de Materials studio .cif arrojará la información cristalográfica del
material incluyendo a los hidrógenos. Ahora, se debe crear un archivo .gin, que fungirá
como el archivo de entrada para GULP. En la Figura 3.4 muestra la nueva información
cristalográfica generada con MS.

Creación archivo .gin

La Figura 3.5 muestra un ejemplo de un archivo “.gin”. En el cual, se debe agregar
datos obtenidos con el cálculo previo en Materials studio, como las coordenadas y los
parámetros de celda. También se debe especificar los archivos de salida, en especial, el
archivo .fdf.

Cabe mencionar, que es necesario que los archivos .gin deben guardarse tres veces
con diferente extensión, y que estos archivos deben encontrarse en la carpeta dentro del
programa donde está el ejecutable “gulp.exe”, para que el cálculo pueda realizarse. Para
fines prácticos, se sugiere que los nombres de los archivos tengan como extensión “.gin”,
“.gin.gin” y “.gin.gin.gin”. El archivo de entrada para GULP es el de la extensión .gin.
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Figura 3.5: Archivo gin

GULP

Ya que se tiene los 3 archivos en la carpeta del ejecutable de GULP, se realizan los
siguientes pasos:

1. Abrir en windows una terminal ”Śımbolo del sistema”.

2. Primero indicar dentro de la terminal la ruta donde se encuentra el programa GULP.

3. Indicar el camino donde se encuentra el ejecutable gulp.exe.

4. Ahora junto con el ejecutable .exe poner el archivo .gin a calcular. Se anexa un
ejemplo particular del trayecto.

5. Este arrojará 5 archivos: .cssr, .arc, .cif, .xyz, .fdf. De los cuales, utilizaremos el .fdf.
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Figura 3.6: Programa GULP

Archivo .fdf

En el archivo .fdf, se hallan las coordenadas del material completo (en la sección %block
AtomicCoordinatesAndAtomicSpecies), número de átomos (NumberOfAtoms) y número
de especies (NumberOfSpecies) que son los datos finales para el input de QE. En la Figura
3.7, se muestra un ejemplo de este archivo.

Figura 3.7: Archivo .fdf
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3.1.2. Input QE

Parámetros para el cálculo

El input para QE requiere parámetros que ayudarán a minimizar el costo computacio-
nal al igual que harán un cálculo más preciso y confiable. Los parámetros importantes
para el cálculo son las enerǵıas de corte (Ecutwfc y Ecutrho) y la convergencia de los
kpoints.

Figura 3.8: Parte de un pseupotencial del tetracianoniquelato de ńıquel

Dentro de estos cálculos, es necesario especificar los pseudopotenciales para cada es-
pecie de átomo dentro del material. En los pseudopotenciales se encuentran los Ecutwfc
y Ecutrho de cada átomo, como se muestra en la Figura 3.8. Por lo que se examina cada
enerǵıa de corte de los diferentes átomos que se encuentran en el material y se observa
la enerǵıa mayor de los ecutwfc y ecutrho. De los valores de enerǵıas obtenidas, se van
variando para encontrar la convergencia de los parámetros. En el caso de los ecutwfc, en
este trabajo, se fue variando de 5 en 5; en el ecutrho se vaŕıa de 50 en 50. El cálculo co-
mienza, variando las enerǵıas ecutwfc hasta encontrar una enerǵıa convergente. Después,
se varia la enerǵıas ecutrho.

En el caso de los Kpoints, debido a la relación inversa entre el espacio rećıproco y el
real, los kpoints se van variando por ejemplo:
1 1 2 1 1 1
2 2 4 1 1 1
3 3 6 1 1 1
aśı sucesivamente. Dicho de otra manera, el tercer número es el doble de los dos primeros.
Esto es debido, a la relación que tienen los parámetros de celda donde un lado es aproxi-
madamente el doble de los otros dos.

En este trabajo la enerǵıa Ecutwfc se varió desde 45 Ry hasta 75 Ry. La enerǵıa
ecutrho fue desde 250 Ry hasta 400 Ry, y los kpoints desde 1 1 2 hasta 5 5 10.

En el caso de los 3 cálculos de convergencia es necesario calcular un “infinito” para
tener una aproximación hacia donde converge el cálculo. Este infinito es un número equi-
librado entre suficientemente grande y no conlleve mucho tiempo de cómputo. Para elegir
la enerǵıa de corte óptima, se realiza el cálculo del siguiente modelo:

(Ecutoff − E(infinito))/(Numerodeatomosdecelda) < 0,01eV
Presion(Ecut)− Presion(infinito) < 1kbar
Fuerza(Ecut)− Fuerza(infinito) < 0,01eV/Amstrongs

(3.1)

Para este trabajo, para ecutwfc tomamos como infinito 95 Ry. Para ecutrho 500 Ry,
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y por último, los kpoints 8 8 16.

La Figura 3.9 presenta un ejemplo de un archivo SCF para realizar los cálculos antes
mencionados.

Figura 3.9: Input de QE

Cálculo de densidad de carga

Encontrados los parámetros óptimos de los materiales, se realiza un cálculo de optimi-
zación. La Figura 3.10 presenta un ejemplo de dicho cálculo. La ĺınea de comando “relax”
representa el cálculo de optimización.

Figura 3.10: Input de optimización de QE
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QE contiene paquetes de “posprocesamiento” para el análisis y grafica de datos. Para
realizar la densidad de cargas, se utiliza el paquete especializado “pp.x”.

El código realiza dos pasos:

1. Lee el archivo de salida producido por pw.x, extrae y calcula la cantidad deseada.

2. Escribe la cantidad deseada para archivar en un formato adecuado para varios tipos
de trazado y varios programas de trazado.

Los datos de entrada de este programa se leen desde la entrada estándar o de archivo
y tiene el siguiente formato:

NAMELIST & INPUTPP
Que contiene las variables para la etapa (1), seguido por
NAMELIST & PLOT
Que contiene las variables para la etapa (2)
Gα,R
ijk (r) = Nα

ijk(x−R1)
i(y −R2)

j(z −R3)
k exp−α(r−R)2

Un ejemplo del input, se muestra en la Figura 3.11

Figura 3.11: Input posprocesamiento de QE

Por último se realiza el calculo “pp.x”. El comando de los cálculos para QE en el
clúster, viene dado por:
mpirun −np procesadores /ruta/pw.x 〈nombre archivo〉 nombre archivo salida.
Para los cálculos posprocesamiento, se cambia “pw.x” por “pp.x”.

Antes de mandar los cálculos de QE a cualquier máquina, debemos cerciorarnos si
el input está correcto; esto se logra visualizando el sistema en estudio con programas
de visualización de moléculas, en este trabajo utilizamos el programa xcrysden. Este
software tiene la herramienta de abrir archivos pwscf.in, que son los archivos requeridos
en QE. Para visualizar el sistema se siguen los siguientes pasos:

Abrir el programa xcrysden.

Ir a File ⇒ Open PWscf ⇒ Open PWscf input file.

Buscar la ruta donde se encuentra el input.

Tanto los parámetros de la celda como las coordenadas, necesitan estar en las mismas
unidades. La metodoloǵıa explicada anteriormente cumple con tal requisito. Cabe men-
cionar que si se tienen problemas con ello, se puede utilizar el software .Atomsk”que arroja
las coordenadas en unidades de Angstroms. Es más fácil que las unidades sean angstroms
al trabajar con sólidos, ya que el archivo .cif cuenta con el tamaño de celda en dichas
unidades.
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3.2. LAMMPS

En estudios de adsorción uno podŕıa conocer la cantidad de material adsorbido como
una función de la presión y temperatura del depósito, con el cual el material está en con-
tacto. Una técnica teórica válida podŕıa ser el uso de técnicas de dinámica molecular para
simular la situación experimental. La simulación molecular es una potente herramienta
para predecir el comportamiento de los sistemas y, a la vez, poder comprender mejor los
procesos de adsorción a nivel molecular.

En una simulación, hay una interface entre la fase gas y el adsorbente. En la región
interfacial las propiedades del sistema son diferentes de las propiedades que se están intere-
sadas. Ya que en una simulación el sistema es pequeño, tenemos que simular un sistema
largo para minimizar la influencia de la región interfacial. Muchos de estos problemas son
resueltos por ensambles.

La mecánica estad́ıstica interpreta las variables macroscópicas como la manifestación
de las propiedades microscópicas individuales de un sistema de muchas part́ıculas. En
particular, se busca deducir las propiedades termodinámicas del sistema macroscópico
basándose en una descripción estad́ıstica. La descripción del estado de un sistema con
N part́ıculas, en mecánica cuántica, llegaŕıa a ser muy complejo porque se tendŕıan que
estudiar muchas variables para cada part́ıcula del sistema. En la misma ĺınea argumental,
podemos considerar poco f́ısico especificar el número de part́ıculas de un sistema ma-
croscópico, ya que resulta imposible en la práctica conocer esta cantidad con precisión.
Por lo que, es mejor especificar cuantas part́ıculas tienen el mismo estado definido por po-
siciones y momentos. Lo único que podemos determinar en un experimento es el número
promedio de part́ıculas

Como un sistema se define por la colección de un gran número de part́ıculas, los “en-
samble”se puede definir como la recopilación de un número macroscópicamente idénticos,
pero sistemas esencialmente independientes. Con el término de medios macroscópicamente
independientes, significa, que cada uno del sistema que constituye un ensamble satisface
las mismas condiciones macroscópicas, como el volumen, la enerǵıa, la presión, la tempe-
ratura y el número total de part́ıculas, etc.

En mecánica estad́ıstica, la función de partición es un funcional de un sistema en equi-
librio. De ella se pueden derivar las funciones de estado, como la presión, temperatura,
entroṕıa, enerǵıa libre, etc. Dependiendo del ensamble estad́ıstico considerado la función
de partición toma una forma u otra. En la práctica es más conveniente calcular variables
termodinámicas a través de la función de partición, definida a partir de las probabilidades
de cada estado.

El método Metrópolis calcula promedios térmicos de funciones que depende de las
coordenadas de una molécula en un sistema de N part́ıculas, como por ejemplo la enerǵıa
potencial o la contribución de la presión. Pero este método no determina el valor de la in-
tegral

∫
drN exp[...βU(rN)]. Por lo que el método Metrópolis no es usado para determinar

propiedades termodinámicas de un sistema que depende de esta integral. A pesar de que
el método Metrópolis no puede ser utilizado para medir enerǵıas libres directamente, este
puede ser utilizado para mejorar la diferencia de enerǵıas libres entre dos posibles estados
de un sistema de N-part́ıculas. Este hecho es explotado en el método gran canónico de
Monte Carlo.
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El método más general para estudiar los procesos de adsorción en equilibrio es a través
de la simulación Monte Carlo y el ensamble gran canónico. Cada simulación Monte Carlo
consiste en millones de movimientos aleatorios: inserción, eliminación, rotación o trasla-
ción de una molécula a través de la porosidad, de los cuales solo algunos serán aceptados.
El requisito para que cada movimiento sea aceptado es que cumpla con un valor de enerǵıa
acorde con la distribución de Boltzmann. Una simplificación de este proceso seŕıa decir que
un movimiento es aceptado si la nueva posición implica una estabilización en la enerǵıa
del sistema. En cada punto de la isoterma se suele realizar un elevado número de mo-
vimientos aleatorios hasta comprobar que se ha alcanzado el equilibrio. A partir de este
momento, los movimientos aleatorios continúan, ahora ya en equilibrio, para poder aplicar
estad́ısticas a nuestro sistema y poder obtener los parámetros macroscópicos necesarios
(por ejemplo, número de moléculas adsorbidas a cierta presión).

Para estudios de adsorción, lo natural es el uso del ensamble gran canónico (o
ensamble(µ, V , T ). Como experimentalmente las condiciones de equilibrio son que la
temperatura y el potencial qúımico del gas dentro y fuera del adsorbente deben ser igua-
les, tenemos que conocer solamente la temperatura y el potencial qúımico depósito para
determinar la concentración de equilibrio dentro del adsorbente. Esto es exactamente lo
que se imita en el conjunto gran canónico: la temperatura y el potencial qúımico son fijos
y el número de part́ıculas fluctúa durante la simulación.

Al fijar la enerǵıa total del sistema a un valor E restringe fuertemente el conjunto de
microestados posibles a aquellos que cumplen esta restricción, o estados accesibles. La
restricción que se impone define el tipo de ensamble estad́ıstico en cuestión. En el caso
del gran canónico, que restringe enerǵıa y número de part́ıculas, E, N. El ensamble gran
canónico, en el cual el sistema puede tener un número arbitrario de part́ıculas, únicamen-
te es especificado su promedio por las condiciones externas. El sistema puede adquirir de
manera estad́ıstica todos los estados accesibles, maximizando el desorden microscópico
del mismo (entroṕıa). Aśı, más allá de cualquier interpretación f́ısica, cabe resaltar que
el uso de uno u otro ensamble en aplicaciones concretas de la teoŕıa depende mas de
conveniencias de cálculo que de consideraciones f́ısicas.

De hecho, la idea detrás de las simulaciones de dinámica molecular es que podemos
estudiar el comportamiento promedio de un sistema de part́ıculas múltiples simplemente
calculando la evolución natural del tiempo de ese sistema numéricamente y promediando
la cantidad de interés durante un tiempo suficientemente largo (Condición ergódica).

LAMMPS es un software que realiza cálculos de dinámica molecular. Dentro de estos
cálculos, se encuentra la obtención de isotermas de adsorción de gases. Otorga información
respecto a la eficiencia de ciertos materiales para tal proceso.

3.2.1. Uso de Materials Studio, Open Babel GUI para la crea-
ción de un input de LAMMPS

LAMMPS es un software que requiere la realización de un archivo de entrada para los
cálculos requeridos. El input de LAMMPS consiste en una serie de ĺıneas de un archivo de
texto ASCII. Para LAMMPS, se requieren dos archivos principales. El primero consiste
en una serie de ĺıneas de comandos, que especifican con detalle el cálculo que se hará en
la simulación. En la página del software se especifica con detalle los comandos y dan un
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panorama general de la utilidad de cada uno de ellos. El segundo consiste, en un archivo
que especifica los parámetros estructurales del sistema. En este archivo se especifican los
tipos de átomos del material adsorbente y adsorbato, con sus respectivas caracteŕısticas.

Para la preparación del input del cálculo de dinámica molecular en LAMMPS, se nece-
sitan varios software, en particular se usó Materials studio (MS) [36], Open Babel GUI [38].

El archivo input de entrada para el primer software a utilizar, MS, es un archivo .cif.
En este software, el archivo de entrada es un archivo .cif, a este se le agregan los hidrógenos
correspondientes a las estructuras, donde se requiera. Además es necesario agregar el force
field al material.

Materials Studio (MS)

A continuación, se presentan los pasos a seguir para la preparación del input en el
software MS.

1. Abrir el programa “Material studio” y crear un proyecto.

2. Ir a File ⇒ Import, y abrir el archivo .cif a trabajar.

3. Para un uso más didáctico, se puede visualizar con más claridad la molécula, cambiar
el modo de visualización dirigiéndose a View ⇒ Display Style. Por ejemplo, a Ball
and Stick.

4. Ir a Build ⇒ Bond, dejar las opciones por default y pulsar “Calculate”, esto para
calcular automáticamente el tipo de enlace (si se desea modificar el tipo de enlace,
seleccionar el enlace, ir a Modify ⇒ Modify Bond type).

5. Para agregar hidrógenos (H) al material, seleccionar la molécula a la cual se le desea
agregar H, ir a Modify ⇒ Modify hibridization, y elegir el tipo de hibridización
dependiendo de la molécula. Después ir nuevamente a Modify ⇒ Adjust Hydrogen.

6. Asignar el campo de fuerza. Ir a Modules ⇒ Forcite ⇒ Calculation.

7. En el recuadro de ”Forcite Calculation”, ir a la pestaña .Energy 2elegir el force field.
Pulsar la opción ”More”.

8. En el recuadro ”Forcite Preparation Options”, deseleccionar la opción Çalculate
automatically 2pulsar Çalculate”(observar en label si el campo de fuerza se aplicó).

9. Se necesita crecer la celda. Ir a Build⇒ Simmetry⇒ Supercell. Cambiar los paráme-
tros como se desee.

10. Para guardar el nuevo archivo, ir a File ⇒ Export, y guardarlo con extensión .msi.

Open Babel GUI

Es necesario cambiar el archivo .msi a .bgf. Esto se realiza con ayuda del software
Open Babel GUI. En el cual, se realizan los siguiente pasos:

1. En la sección ÏNPUT FORMAT”, elegir msi, cargar el archivo.
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2. En la sección .OUTPUT FORMAT”, elegir la opción bgf, poner nombre al archivo
output. Es importante deseleccionar la opción .Output below (no output file)”. Pulsar
CONVERT.

El archivo .bgf, no contiene la información de la celda, por lo que es necesario agregarlo
manualmente; esto se logra con la siguiente ĺınea: CRYSTX A B C ANGULOA ANGU-
LOB ANGULOC. Esta ĺınea debe estar necesariamente después de la ĺınea ”FORMAT
ATOM”. El archivo modificado .bgf, se debe pasar a una máquina con lenguaje perl.
Para este trabajo, se contó con un programa denominado createLammpsInput.pl, el cual,
apartir del archivo .bgf crea tres archivos:

data.nombrearchivo, in.nombredearchivo, in.nombredearchivo singlepoint.

El archivo data.nombrearchivo es el archivo que contiene la información de la estruc-
tura para el cálculo. Para cálculos de adsorción, la estructura debe ser ŕıgida, por lo que
se debe eliminar la información de ángulos, enlaces, ángulos diedros. De igual forma, el
archivo in.nombredearchivo es un ejemplo del archivo input para LAMMPS, pero este no
contiene información GCMC. Para detalles del input para cálculos de GCMC, se puede
revisar en la página del software.
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Caṕıtulo 4

RESULTADOS Y DISCUSIÓN

El trabajo está enfocado al análisis de 6 sistemas tetracianoniquelatos, como posibles
candidatos para procesos de adsorción de H2. Dentro de estos sistemas se vaŕıan dos fac-
tores: el anillo (imidazol y piridina) que funge como pilar de soporte entre láminas, y el
metal externo (Ni, Co, Fe) unido a dichos anillos.

Se efectuaron cálculos de enerǵıa para encontrar los parámetros óptimos que son re-
queridos para el cálculo de la optimización de las estructuras. Luego, a partir de las
geometŕıas optimizadas, se realizaron cálculos de densidad electrónica que muestran los
sitios probables de interacción entre las moléculas huésped y las superficies adsorbentes.
Posteriormente, con el objetivo de evaluar y comparar el desempeño de estos materia-
les como candidatos para el almacenamiento de hidrógeno, se simularon las isotermas de
adsorción.

4.1. Parámetros óptimos

Los cálculos DFT fueron desarrollados con el código de QE. Fueron usados los pseu-
dopotenciales PAW [39]. Durante todo el cálculo, fue utilizado un funcional de Aproxima-
ciones del Gradiente Generalizado (GGA) [40], espećıficamente Perdew-Burke-Ernzerhof
(PBE) [41]. Las coordenadas iniciales de los 6 sistemas fueron tomadas de los archivos
CIF reportados en la literatura [3, 42]. Primeramente, se realizó un cómputo de enerǵıas
para determinar los parámetros óptimos requeridos para los cálculos posteriores; estos
parámetros convergentes son las enerǵıas ecutwfc y ecutrho, al igual que los puntos k.

Se realizaron cálculos de enerǵıa de corte ‘ecutwfc’, para los sistemas: Co(Im)2[Ni(CN)4],
Ni(Im)2[Ni(CN)4], Co(py)2[Ni(CN)4], Ni(py)2[Ni(CN)4], y otro para los sistemas:
Fe(Im)2[Ni(CN)4] y Fe(py)2[Ni(CN)4]. El resultado de la primera convergencia se muestra
en la Figura 4.1a, donde se puede apreciar que a partir del valor ecutwfc = 70 Ry la dife-
rencia de los valores obtenidos no es significativa, por lo cual, a partir de 70 Ry la enerǵıa
en el sistema empieza a ser convergente. Este cálculo cualitativo, debe complementarse
con las condiciones que se mencionaron en la ecuación 3.1. De igual forma, en la Figura
4.1b no se aprecia una tendencia clara; sin embargo, la ecuación 3.1 dedujo que la enerǵıa
converge a partir de 75 Ry.

En la gráfica de la Figura 4.2a se muestra la enerǵıa óptima para el cálculo en QE
de la enerǵıa ecutrho de los materiales con metal externo Ni y Co. Los cálculos de la
ecuación 3.1 dieron como resultado que a partir de 250 Ry, la enerǵıa no vaŕıa de forma
significativa. Para los sistemas con Fe, sucedió lo mismo que para los otros sistemas; en
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(a) Co y Ni (b) Fe

Figura 4.1: Gráfica de Enerǵıa vs Ecutwfc

(a) Co y Ni (b) Fe

Figura 4.2: Gráfica de Enerǵıa vs Ecutrho

este caso, la enerǵıa óptima fue de 780 Ry. Ver Figura 4.2b.

Como se muestra en la Figura 4.3a y b, a partir de los Puntos k 2 2 4, la curva muestra
una tendencia de convergencia para todos los sistemas.

En resumen, los parámetros óptimos para los sistemas con Ni y Co son: ecutwfc = 70
Ry, ecutrho = 250 Ry, y Puntos k 2 2 4. Para los sistemas con Fe dio como resultado:
ecutwfc = 75 Ry, ecutrho = 780 Ry, y los Puntos k= 2 2 4. Los resultados anteriores, son
los parámetros requeridos para el cálculo de optimización de las estructuras.

4.2. Optimización de la geometŕıa de los TCN

Se realizó un cálculo de optimización de todas las posiciones atómicas de la celda
usando el algoritmo de Davidson [43] para los TCN. Como se puede observar en la Figura
4.4, al comparar las series de imidazol (Im) y piridina (Py), se nota que en la primera las
láminas formadas por las unidades de [Ni(CN)4]

−2 aparecen ondulas a lo largo del plano
XY. El origen de esta distorsión estructural puede atribuirse a las diferencias en tamaño
y simetŕıa de los anillos Im y Py (ver Figura 4.5).
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(a) Co y Ni (b) Fe

Figura 4.3: Gráfica de Enerǵıa vs puntos k

En los sistemas con imidazol, debido a la disposición geométrica de los anillos y a la
simetŕıa interna de los mismos, se observa dos tipos de canales que corren en la dirección
z el canal A y el canal B (Ver Figura 4.6a). En el canal A los enlaces C-H de los carbonos
4 y 5 del anillo aparecen enfrentados, mientras que en el canal B solo están presentes los
enlaces C-H del carbono 2, dejando un espacio libre mayor. Por otro lado en la serie con
Py, la alta simetŕıa de este anillo conduce a la formación de un solo tipo de canal (ver
canal C en la Figura 4.6), dado que existe el mismo impedimento estérico en ambos lados
del metal octacoordinado (en la dirección x ).

Ahora bien, al ser el imidazol más pequeño que la piridina, la distancia entre las lámi-
nas (L) es más pequeña en la serie del primer anillo (ver Tabla 4.1) lo cual provoca que
la repulsión estérica entre los enlaces C-H del anillo y los grupos CN de las láminas sea
mayor respecto al caso con Py. Este efecto repulsivo es mucho más acentuado en el canal
A que en el B, por lo que el sistema puede estabilizarse mediante el desplazamiento de los
cationes Ni(II) de las láminas en el sentido de A hacia B (ver el sentido de las flechas en
la Figura 4.6). Este desplazamiento (∆) en el eje Y respecto a los cationes octahédricos
(inexistente en la serie de piridina) causa la ondulación de las láminas de TCN. En la Ta-
bla 4.1 se puede notar que la magnitud del desplazamiento aumenta en el mismo sentido
en que disminuye la distancia interlaminar (aunque las diferencias en L son pequeñas), lo
que corrobora que la distorsión de las láminas puede tener un origen estérico. Igualmente
se reporta el valor del ángulo diedro laminar T-Ni-T-Ni cuya desviación de 180° es tam-
bién una medida de la distorsión de las láminas de TCN.

Tabla 4.1: Tabla de medidas de parámetros geométricos

Metal externo L (Å) ∆ (Å) DT−Ni−T−Ni

Imidazol
Ni 6.686 0.554 168.0
Co 6.680 0.561 167.5
Fe 6.679 0.588 166.9

Piridina
Ni 7.643 0 180.0
Co 7.703 0 180.0
Fe 7.763 0 180.0
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(a) (b) (c)

(d) (e) (f)

Figura 4.4: Se muestran las estructuras optimizadas de a) Ni(Im)2[Ni(CN)4]; b)
Co(Im)2[Ni(CN)4]; c) Fe(Im)2[Ni(CN)4]; d) Ni(Py)2[Ni(CN)4]; e) Co(Py)2[Ni(CN)4]; f)
Fe(Py)2[Ni(CN)4]; Negro= C, azul= N, azul claro= H, verde= Ni, morado= Co y rojo=
Fe

(a) (b)

Figura 4.5: Estructura del imidazol (a) y la piridina (b)
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(a) T(Im)2[Ni(CN)4 (b) T(Py)2[Ni(CN)4

Figura 4.6: Representación de canales en los TCN (Negro= C, azul= N, azul claro= H,
verde= Ni, morado= Co)

Existen otros parámetros geométricos a destacar en las estructuras optimizadas, pero
serán retomados el próximo eṕıgrafe.

Las observaciones anteriores permiten suponer que los diferentes tipos de estructura
que presentan los TCN (onduladas o planas), puede inducir a que se presenten diferen-
tes distribuciones de densidades electrónicas entre ellos, gracias a los diferentes canales
observados.

4.3. Distribuciones de densidad electrónica

A partir de las geometŕıas optimizadas se generaron los mapas de densidad electrónica
en distintos planos de la estructura. La Figura 4.7 muestra algunos de estos resultados
para los 6 TCN que nos ocupan; la mayor densidad electrónica se representa en color azul,
la menor en color rojo y densidades electrónicas intermedias se representan de color verde.
Para los TCN Im (ver Figura 4.7b-d) se muestra el plano YZx= 1

4
, mientras que para los

TCN Py (ver Figura 4.7f-h) se observa el plano XYz = 0.

Se escogieron apriori estas proyecciones porque presentaban las zonas donde se obser-
vaban a simple vista los mayores gradientes de densidad electrónica. Estos planos cortan
transversalmente las láminas de [Ni(CN)4]

−2 a través del catión con coordinación cua-
drado plano y atraviesan los canales en dirección transversal a los anillos (eje z ), pero sin
tocarlos (ver Figura 4.7a y e).

Analizando cada conjunto, no se observa una diferencia significativa entre los TCN Im,
al igual que entre los TCN Py. Por tal motivo, para fines prácticos se analizó una estruc-
tura de cada uno de los sistemas. En la Figura 4.8, se muestra una ampliación de los
planos considerados para cada serie. Se observa que en el TCN Im (Figura 4.8a) existe
una marcada simetŕıa de la densidad electrónica que rodea al Ni en posición axial; dicha
simetŕıa está relacionada directamente con la diferenciación espacial que da lugar a los
canales A y B. De esta forma, en los canales A, donde los cationes con el Ni(II) están más
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(a)

(b) (c) (d)

(e)

(f) (g) (h)

Figura 4.7: a) Plano YZx= 1
4

en los TCN Im; b) Proyección del plano YZx= 1
4

en

Ni(Im)2[Ni(CN)4]; c) Proyección del plano YZx= 1
4

en Co(Im)2[Ni(CN)4]; d) Proyección

del plano YZx= 1
4

en Fe(Im)2[Ni(CN)4]; e) Plano XYz= 1
2

en los TCN Py; f) Proyección del

plano YZx= 1
4

en Ni(Py)2[Ni(CN)4]; g) Proyección del plano YZx= 1
4

Co(Py)2[Ni(CN)4]; h)

Proyección del plano Fe(Py)2[Ni(CN)4]
.
46



(a) TCN Im en el plano YZx= 1
4

(b) TCN Py en el plano XYz=0

Figura 4.8: Mapas de densidad electrónica. Los gradientes más significativos se representan
con una flecha

separados y la distancia entre dos anillos contiguos es pequeña, los gradientes de densidad
electrónica son pequeños al ocurrir un solapamiento parcial de sus nubes electrónicas.
Sin embargo, en los canales B donde las nubes electrónicas de los anillos no se solapan
debido a que están a una mayor distancia entre ellos, y donde los cationes Ni(II) están
más cercanos, la densidad electrónica cae bruscamente a cero desde los metales hacia el
centro de los canales, generando aśı fuertes gradientes eléctricos en toda la estructura en
la dirección z del cristal.

Por otra parte, en los TCN Py (Figura 4.8b) la distribución de densidad electrónica
a lo largo de las zonas axiales de los Ni(II) es intermedia respecto a la existente en los
canales A y B del Im. Como resultado el canal C presenta gradientes menos numero-
sos y menos marcados que los presentes en el canal B del Im. Estas diferencias en las
distribuciones de densidad electrónica de ambas series podŕıan tener efectos importantes
en sus propiedades adsorbentes hacia una molécula con momento cuadrupolar como el H2.

Volviendo al caso de la serie TCN Im, resulta interesante comprobar si la marcada
simetŕıa en las distribuciones de densidad electrónica entre los canales A y B se verifica
entre los diferentes planos del cristal. Un estudio detallado se expone en la Figura 4.9
donde se representa otros 3 planos:

a) XYz=0: cortan las láminas longitudinalmente conteniendo a los Ni(II) cuadrado pla-
nos de una lámina y a los metales octahédricos (junto a los dos anillos enlazados a este de
láminas adyacentes)(Figura 4.9a). Aqúı los gradientes se generan en la dirección axial al
Ni hacia dentro de los canales B, aunque también se presentan gradientes transversales del
anillo hacia el centro del canal (Figura 4.9b). A diferencia del plano YZx= 1

4
, los gradientes

en este canal no forman un continuo. Respecto al canal A sucede algo similar que en el ca-
so del YZx= 1

4
, pues la cercańıa entre los anillos provoca que la distribución de densidades

electrónicas sea más homogénea, disminuyendo aśı la magnitud de los gradientes eléctricos.

b) XYz= 1
4
: Al igual que el anterior va paralelo a las láminas, pero ahora corta a los

grupos CN y atraviesa la región entre dos anillos con interacción π−π entre ellos (Figura
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4.9c). Los gradientes más intensos se generan interrumpidamente en la región interlaminar
del canal B, generados en este caso por 4 grupos CN (Figura 4.9d).

c) XZy= 1
4
: Este plano es equidistante de dos láminas adyacentes y corta transversal-

mente a los anillos Im (Figura 4.9e). En este caso, los gradientes se deben exclusivamente
a la densidad electrónica de los anillos. En el canal A los gradientes son poco marcados por
la corta distancia entre los anillos, pero en el B la densidad electrónica cae rápidamente a
cero en los espacios libres, generándose gradientes más intensos que forman un continuo
a lo largo de la dirección z del cristal (Figura 4.9f).

Concluyendo, el análisis de todos los planos considerados concuerda en que la dife-
rencia en el espaciamiento molecular que ocurre en los canales A y B de los Im provoca
una marcada asimetŕıa de las distribuciones de la densidad electrónica en cada canal. Aśı,
mientras en A la densidad electrónica es relativamente homogénea, en B ocurren cambios
bruscos lo que genera en esta zona fuertes gradientes eléctricos. Dichos gradientes ocurren
principalmente en direcciones axiales a los Ni(II) con coordinación cuadrado plano y en
dirección transversal a los anillos Im, en ambos casos apuntando al centro del canal y
extendiéndose preferencialmente a lo largo del eje z del cristal. Por tanto, seŕıa de esperar
que estos sitios sean los preferenciales para la adsorción de H2, suponiendo que en el sis-
tema TCN-H2 predominaran las interacciones gradiente eléctrico-momento cuadrupolar.

Para probar esta hipótesis se realizó, un cálculo de optimización de la estructura CoIm
con una molécula de H2 en el interior del enrejado. El resultado se muestra en la Figura
4.10.

En primer lugar, se aprecia que el H2 se ubica preferencialmente en el canal B, en
dirección axial a uno de los Ni(II) cuadrado plano y prácticamente equidistante de dos
anillos Im (Figura 4.10a). Una inspección al mapa de densidad electrónica resultante en
el plano YZx= 1

4
(Figura 4.10b), muestra la interrupción de la zona continua de muy baja

densidad electrónica producto del solapamiento de las densidades electrónicas del TCN
y el H2 el cual se ubica en una región donde confluyen los gradientes provenientes de 3
átomos de Ni(II) (comparar con Figura 4.8a). Evidencias similares pueden extraerse de
los mapas de densidad electrónica en el resto de los planos considerados (ver Figura 4.10c
y d): la molécula de H2 se ubica en las zonas donde confluyen los gradientes eléctricos más
intensos, de ah́ı que sea factible suponer la presencia de fuertes interacciones gradiente-
cuadrupolo.

Resumiendo, uno de los sitios probables que dedujo el cálculo de densidad electrónica
del material sin H2, concuerda con el arrojado por el cálculo incluyendo H2; esta coinci-
dencia muestra el carácter predictivo que tiene la metodoloǵıa empleada para determinar
cualitativamente los sitios de adsorción más probables. En próximo eṕıgrafe, profundiza-
remos más al respecto.
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(a) (b)

(c) (d)

(e) (f)

Figura 4.9: a) Plano XYz=0; b) Proyección del plano XYz=0 en los TCN Im; c) Plano
XYz= 1

4
; d) Proyección del plano XYz= 1

4
en los TCN Im; e) Plano XZy= 1

4
; f) Proyección

del plano XZy= 1
4
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(a) (b)

(c) (d)

Figura 4.10: a) Optimización de TCN-H2; b) Proyección del plano YZx= 1
4
; c) Proyección

del plano XYz= 1
2
; d) Proyección del plano XZy= 1

4
)
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4.4. Isotermas de adsorción

Las isotermas de adsorción fueron simuladas con el código LAMMPS usando una su-
percelda de 8 celdas unitarias en todos los TCN. Para el cálculo de la enerǵıa se empleó
el potencial de Lennard-Jones, con parámetros tomados del Universal Force Field (UFF);
este campo de fuerza incluye interacciones covalentes, Van der Waals y electrostáticas. La
enerǵıa de corte fue de 12.5 Å. Las simulaciones de dinámica molecular fueron desarrolla-
das a una temperatura de 77 K con un paso de 1000 fs.

La simulación de Monte Carlo Gran Canónico fue usada junto con el modelo del átomo-
unido para las moléculas de H2. Los parámetros utilizados para el H2 fueron tomados de
la literatura [44–46]. Las moléculas de H2 fueron intercambiadas entre las celdas unitarias
de los TCN a 77 K; además del rango de valores de potencial qúımico (-1.9675 a -0.5309
kcal/mol) correspondientes al rango de presiones de 0.01 a 120 atm. Los materiales se
mantuvieron estacionarios en la simulación manteniendo las coordenadas atómicas de las
geometŕıas optimizadas. Las simulaciones fueron desarrollados en un rango de presiones
bajas (hasta 1 atm) y a presiones altas (hasta 120 atm) para la construcción de las iso-
termas. Un total de 1x106 ciclos Monte Carlo fueron desarrollados para cada punto.

La Figura 4.11 muestran las isotermas de adsorción de H2 en los TCN para altas y
bajas presiones, respectivamente. De manera general, se observa que la adsorción aumenta
en un orden de magnitud al pasar de la serie Py a la serie Im. Es notable que a bajas
presiones, las isotermas de los TCN Im presentan una pendiente mucho más pronunciada
que los TCN Py, lo cual sugiere que en la primera serie las moléculas de H2 se adsorben
mediante fuertes interacciones huésped-hospedero. Por otra parte, se aprecia que en los
TCN Py las curvas de adsorción presentan un comportamiento lineal en todo el rango de
presiones, representativo de isotermas tipo Henry donde existe poca interacción huésped-
hospedero y la cantidad de moléculas adsorbidas es directamente proporcional a la presión.

La curva de adsorción que presenta los TCN Im sigue un comportamiento tipo Lang-
muir. Este tipo de isotermas es representativo de materiales que tienen sitios de interacción
espećıficos que se van ocupando en la medida en que aumenta la presión del gas, hasta
que la adsorción alcanza un valor asintótico que representa la capacidad máxima de ad-
sorción (Qmax) del material y que implica la formación de una monocapa de gas. De
acuerdo al valor de la pendiente de las isotermas a bajas presiones en los TCN Im, la
fortaleza de las interacciones sigue el orden CoIm > FeIm > NiIm. Este comportamien-
to puede racionalizarse a partir del análisis de las distancias de enlace en los complejos
[Ni(CN)4]

−2. A partir de la tabla (4.2) se puede observar que la distancia de enlace C-N
del grupo ciano aumenta en el orden NiIm < FeIm < CoIm, mientras que la distancia
C-Ni presenta un orden inverso. Ambas tendencias sugieren que el efecto de retrodonación
π-Metal(→)-Ligando (Ni→) sigue el orden CoIm > FeIm > NiIm, ya que la inyección de
electrones desde el Ni(II) hasta el orbital antienlazante del grupo CN debilita el enlace
C-N, a la vez que refuerza el enlace Ni-C. El hecho de que la fortaleza de las interacciones
TIm-H2 esté en concordancia con el efecto de retrodonación π del Ni(II) cuadrado plano
en TIm, sugiere que ambos fenómenos pueden estar relacionados. Una posible explica-
ción es la siguiente: una mayor retrodonación implica que el Ni(II), al deshacerse más
efectivamente de la densidad electrónica donada por el ligando CN a través del enlace
σ-Ligando(→)-Metal, queda cargado más positivamente, de ah́ı que este genere campos
eléctricos más fuertes que a su vez genere gradientes más intensos. Asumiendo que las in-
teracciones gradiente-cuadrupolo tienen un peso importante en la enerǵıa de interacción,
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(a) (b)

Figura 4.11: a) Isotermas de adsorción de H2 a 77 K para los materiales estudiados:
TA[Ni(CN)4]

−2, T = Ni2+, Co2+, Fe2+, A= Im, Py; b) Región de bajas presiones de las
isotermas de adsorción de H2 a 77 K para los materiales: TA[Ni(CN)4]

−2, T = Ni2+, Co2+,
Fe2+, A= Im, Py;

se puede afirmar que en este caso mientras mayor es la carga del Ni(II) cuadrado plano,
mayor es la capacidad de adsorción del compuesto laminar. Esta relación entre la carga
de un metal con esfera de coordinación incompleta y la enerǵıa de interacción con el H2

a través de interacciones electrostáticas, ha sido reportada en varios trabajos [46–48].

XXXXXXXXXXXXMaterial
Medidas

N-C (Å) C-Ni (Å)

Co(Im)2[Ni(CN)4] 1.1305 1.9075
Fe(Im)2[Ni(CN)4] 1.112 1.9195
Ni(Im)2[Ni(CN)4] 1.1035 1.9355

Tabla 4.2: Tabla de distancias de TCN Im

4.5. Sitios preferenciales de adsorción de H2

Con ayuda del programa OVITO [49], se desarrolló un video que muestra los cálculos
de dinámica molecular realizados con LAMMPS. Este programa cuenta con la herramien-
ta de poder observar cómo se adsorben y desorben moléculas a diferente intervalos de
tiempo, por lo que es posible determinar los sitios preferenciales de adsorción dentro del
material, especialmente si se tienen en cuenta los puntos de muy baja presión.

En la Figura (4.12a) se muestra la proyección de las coordenadas de las moléculas
de H2 (puntos negros) en el mapa de distribución de densidad electrónica en el plano
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(a) (b)

Figura 4.12: (a) Proyección de las moléculas adsorbidas de H2 en el plano XYZ= 1
4
; (b)

Dispersión en la coordenada x alrededor de X=1
4

YZX = 1
4

para el CoIm a 0.01 atm. Primeramente, se observa que todas las moléculas se
sitúan en el canal B; además, es evidente que la mayoŕıa se concentra en las zonas donde
se verifican los mayores gradientes de campo eléctrico (debidos a los átomos de Ni(II)
cuadrados planos), lo cual está en concordancia con lo que se hab́ıa predicho teniendo en
cuenta solo los mapas de distribución. La alta afinidad de las moléculas por este plano
en particular se verifica al notar que la coordenada en x es prácticamente constante para
todas las moléculas (ver Figura (4.12b)). La aparición de algunas moléculas en regiones
más cercanas a los metales indica que, además de las interacciones gradiente-cuadrupolo
(proporcionales a r−3), están presentes en menor medida interacciones ion-dipolo indu-
cido (proporcionales a r−4), pues estas interacciones son efectivas a menores distancias.
La cercańıa de las moléculas a los Ni(II) sugiere su alta influencia en las propiedades
de adsorción, lo cual está en concordancia con lo observado en las tres isotermas de la
serie Im. Por otra parte, cabe destacar que al proyectar las coordenadas de la molécula
de H2 (punto blanco) obtenidas por DFT (ver eṕıgrafe anterior) las coordenadas en x y
y son muy similares a las obtenidas por dinámica molecular; las diferencias en la coor-
denada z puede deberse a las diferencias intŕınsecas a la naturaleza de los cálculos [46].
Las proyecciones de las moléculas adsorbidas en otros dos planos estudiados se presen-
tan en la Figura (4.13a y 4.14a), donde los gradientes dependen fundamentalmente de
los anillos pilares y los grupos CN, respectivamente. En ambos casos se aprecia que los
sitios efectivos son privativos del canal B y que se distribuyen menos selectivamente en
las zonas con mayor gradiente de carga, por lo que es posible que estén contribuyendo a
la enerǵıa interacciones dispersivas del H2 con los ligandos. El hecho de que la dispersión
en la coordenada transversal (Figuras 4.13b y 4.14b) sea mayor en estos casos que para
el plano YZX = 1

4
, indica que los efectos electrostáticos de los metales son más eficientes

para la adsorción que las interacciones provenientes de los anillos imidazol y los grupos CN.

Un análisis similar se efectúo para el compuesto CoPy a una presión de 0.075 atm.
La Figura (4.15 a) muestra la proyección de las coordenadas de las moléculas de H2 en el
plano XYZ=0; este plano es el homólogo al YZX= 1

4
de la serie Im y es donde se esperaba a

priori que ocurrieran las interacciones más fuertes por el efecto electrostático de los Ni(II)
cuadrado planos. Como puede observarse, a diferencia del caso anterior, las moléculas
tienden a concentrarse en el centro de las zonas con muy baja densidad electrónica, y
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(a) (b)

Figura 4.13: (a) Proyección de las moléculas adsorbidas de H2 en el plano XZY= 1
4
; (b)

Dispersión en la coordenada y alrededor de Y=1
4

(a) (b)

Figura 4.14: (a) Proyección de las moléculas adsorbidas de H2 en el plano YZX= 1
4
; (b)

Dispersión en la coordenada z alrededor de Z=1
4
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(a) (b)

Figura 4.15: (a) Proyección de las moléculas adsorbidas de H2 en el plano XYZ=0; (b)
Dispersión en la coordenada z alrededor de Z=0

donde la distribución de carga es homogénea, lo cual sugiere que las interacciones elec-
trostáticas son débiles. Además, es notable la dispersión que presenta la coordenada z
(ver Figura 4.15b) respecto al valor de cero, indicando que este plano no está favorecido
en los sitios de adsorción.

Las Figuras (4.16a) y (4.17a) muestran las proyecciones en los planos XZY= 1
4

y YZX= 1
4
.

En el primero los gradientes eléctricos se deben a los grupos CN de las láminas en menor
medida a los anillos piridina, mientras que en el segundo se deben exclusivamente a los
anillo. Al analizar ambos casos se puede apreciar que no hay canales preferenciales den-
tro del material, lo cual era de esperarse debido a su distribución espacial homogénea.
Además, se vuelve a notar la presencia de moléculas en zonas donde las interacciones elec-
trostáticas son poco intensas, aunque no se descarta para algunas moléculas interacciones
gradiente-cuadrupolo. Por otra parte, la relativa baja dispersión en la coordenada trans-
versal a los planos en cuestión (ver Figuras 4.16b y 4.17b) sugiere la existencia de zonas
preferenciales de adsorción, en las que deben ser importantes las interacciones dispersivas
con los anillos. Justamente, el hecho de que la adsorción de H2 en esta serie dependa
mayormente del pilar, explica que las tres isotermas TPy no muestren diferencias signifi-
cativas en el rango de bajas presiones.

Resumiendo, a partir de los estudios de Dinámica Molecular es posible afirmar que
existen diferencias significativas entre las series de Im y Py en cuanto a los sitios e inten-
sidad de adsorción de H2. Para el caso de los compuestos con Im, la adsorción ocurre en
sitios muy espećıficos con fuertes interacciones electrostáticas que dependen en gran me-
dida de los centros metálicos cuadrado planos. Sin embargo, para los compuestos con Py
hay una mayor dispersión espacial de las moléculas a lo largo de los canales y se verifican
interacciones débiles que involucran principalmente a los anillos. Estas conclusiones están
en concordancia con los resultados obtenidos en la simulación de las isotermas, tanto en
la diferencia marcada entre las dos series en las que se vaŕıa el pilar, como en las variacio-
nes (sensibles en el Im, poco importantes en Py) dentro de cada serie al variar el metal
externo.
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(a) (b)

Figura 4.16: (a) Proyección de las moléculas adsorbidas de H2 en el plano XZY= 1
4
; (b)

Dispersión en la coordenada y alrededor de Z= 1
4

(a) (b)

Figura 4.17: (a) Proyección de las moléculas adsorbidas de H2 en el plano YZX= 1
4
; (b)

Dispersión en la coordenada x alrededor de X= 1
4
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Caṕıtulo 5

CONCLUSIONES

1. Los TCN estudiados presentan dos tipos de estructuras en sus láminas que dependen
del anillo usado como pilar. En los TCN Im, los Ni(II) de las unidades [Ni(CN)4]

−2

se desplazan en el eje z para minimizar los efectos estéricos, lo que provoca que
las láminas se encuentren onduladas, mientras que en los TCN Py las láminas se
mantienen planas. Esta diferencia estructural provoca que en los TCN Im se originen
dos tipos de canales (A y B); en cambio, para los TCN Py solo se presente un tipo
de canal (C).

2. Se presentan diferencias en la distribución de densidad electrónica para cada tipo
de estructura. En los TCN Im, el canal A presenta pequeños gradientes eléctricos,
mientras que en el canal B se observan cambios bruscos en las densidades, provo-
cando fuertes gradientes eléctricos a lo largo del material. En el caso de los TCN Py,
los gradientes eléctricos son menos marcados que los originados en el canal B.

3. Las isotermas de adsorción simuladas a 77 K muestran que los TCN Im adsorben
mejor que los TCN Py en todo el rango de presiones, verificándose dos fenomeno-
loǵıas diferentes para cada serie. El proceso de adsorción de H2 en los TCN Im es
tipo Langmuir, y parece estar dominado por fuertes interacciones en sitios espećıfi-
cos que son sensibles al cambio de metal externo, siendo el Co(Im)2[Ni(CN)4] el
material que presenta mayor capacidad de adsorción de H2. En la serie TCN Py el
proceso de adsorción es tipo Henry y no presenta variaciones importantes al cambiar
el metal externo.

4. Los resultados de DFT y de Dinámica Molecular concuerdan en los sitios factibles
para una interacción huésped-hospedero, mostrando que el canal B de los TCN Im
presentan fuertes y mayores interacciones H2-hospedero dominadas por interaccio-
nes electrostáticas entre el momento cuadrupolar del H2 y el gradiente de campo
eléctrico generado por los centros metálicos cuadrado planos. Por otra parte, en los
TCN Py las interacciones son más débiles y menos espećıficas, dependiendo mayor-
mente de interacciones que involucran al anillo aromático.
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[37] J.D. Gale and A.L. Rohl. The general utility lattice program. Mol. Simul., 2003.

[38] openbabel.org.
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